
.. 

DIVISION DE EDUCACION CONTINUA 
FACULTAD'DE'INGENIERIA, UNAM 

CURSOS ABIERTOS 

.CURSO: CC65 VISUAL BASIC 3.0 AVANZADO 
FECHA: 1 al 12 de julio de 1996 
EVALUACIÓN DEL PERSONAL DOCENTE 
(ESCALA DE EVALUACIÓN: 1 A 10) 

CONFERENCISTA DOMINIO USO DE AYUDAS COMUNICACIÓN .. PUNTUALIDAD 

DEL TEMA AUDIOVISUALES CON EL ASISTENTE 

ING. ALil1A .ANDBEA GARCIA OLEA .. '. 
ING. MARTBA OCAI11PO ORTIZ ·· · 

tv1 \¡ 1·.U.í: 1:~01~~-.)~ .' ¡ 

i~H.:;.;;- )!~:~·!!li!~r¡,Hlr\ll ·:t .. , 
;i~!J)'~l::n;z,:-:i .:li.l.v;t':nnliG'll d 

·" •• ' •• 1 ' •• --•:;. •• ' 

Promedio ----
EVALUACIÓN DE LA ENSEÑANZA 
CONCEPTO 

. 
CALIF. 

ORGANIZACIÓN Y DESARROLLO DEL CURSO , 

GRADO DE PROFUNDIDAD DEL CURSO . ····- .. . .. 

ACTUALIZACIÓN DEL CURSO .. . --- -~ . . .. .. 
APLICACIÓN PRACTICA DEL CURSO . ····· . . ... P.romedio .. __ . .... . .... 

··-·- ---- . _ _._. _ _. ....... ~ ..... ----~-· ....... . 
. EVALUACIÓN DEL CURSO 

CONCEPTO CALIF. 

CUMPLIMIENTO DE LOS OBJETIVOS DEL CURSO 

CONTINUIDAD EN LOS TEMAS 
. 

CALIDAD DEL MATERIAL DIDÁCTICO UTILIZADO Promedio 
... - ' ..... ,-, .. ,-, ..... e;:: .•. :::: ••• :::: ..... ::::: ..• :-

Evaluación total del curso _____ _ Continúa;·:.2 



,·::,.a_:l· '::". ~ ... 1fr• • '1'(~.":\·.··.;,:r.,; . ~--.:·;:.:.j_ ,._ : ' . . ~ . : • . 
.1. ¿te· agradó su estancia en la División de Educación Continua? r·:. -: ._.\;- .. · . . , .. 1 • • 

SI 

Si indica que "NO" diga porqué: •• ·- •1 

2. Medio a través del cual se enteró del curso: 
1 • 

i 
Periódico Excé/sior ' ·' .. , .. : : .. ,. 
Periódico L<Í Jornada 1 i ! ' ¡ . 

: Folleto anu.il ! : 
1 
' ' 1 Folleto del curso ' i 
[ Gaceta UNAM ' . ' r 
: Revistas técnicas ' .. 
! i 
i Otro medio (Indique cuál) 1 

1 
1 1 
¡· 3: ·¿Qué cambios sugeriría al curso para mejorarlo? 

/ 

,-------, 
NO 

,, 

'• . •' .· .. ::: .. :~~;¡¡'(:.'(.•::.~ :, 

--~-\·,::·:~ ~-~;·;:: r:;~~/:.:{L 

; .. • . . ; :;.y .. ,;, .. :: ,: . \'.Z;~·::._;; .. ·¡::.;~\:¡;:~¿~~~~r; ij 
-

.. 

. 

·t : -~ -~---~-r-. r:: ... .r-·. ~ ... :, ~ ~-l-~ ~. ~:.. r~;;~ í~;.:;·lf~\.ii,1!J·~~-;.}¡' ·~ ¡ 1 

---. · ............. - ...... --... -, -~"''''~o.c:·.-1'.! 

..... --,--~--- -:- -:-~---.- ·-:-:-·::·i l 

' 1 

- --'- -- ~~--------- -·- --------- ~-----= .. ·---¡- - j 

-.::-~=~~~==.:=:··:::·~~.:r 1 
i 

. 1 
··----- . .._.. .. --~- --·-- -- •·---·---~·r:--:-··-·:-"':"""! ···[ 

' : 
.......... ---- --------~,-;--.----'::"'-:-:':'"";'~. -j 

., .·c ... , ···"•-·.-·;·o·."c·.·.J. J 

f-· . 1'. • • ""7: :: :-:-~.'7- :·o:-.:..;=:-:. .. . ! 

i 
1 4. ¿Recomendaría el curso a otra(s) persona(s) ? 

---------------------------~------------------------~ ' 
1 i · ... ·--· .,., ......... ~-·c·c.-7.: .. ·¡ 

--- --- -·· ... -- ~~ 1 

. ··--· - -·--- J • ......... TI 
............................ \ 

SI NO ---- .1 . í 1 ¡ 

6. Otras sugerencias: 



FACUL TAO DE INGENIERIA U.N.A.M. 
DIVISION DE EDUCACION CONTINUA 

";-

COMPLEMENTO DE MATERIAL DIDACTICO 

DEL CURSO 

VISUAL BASIC 

AVANZADO 

• < 

JULIO, 1996 

; .. 

., ., 

·•. 

;.,.._' 

)' 

: i. 

•·· 

Palac10 de Minería Calle de Tacuba 5 Primer piso Deleg. Cuautttémoc 06000 México, D.F. APDO. Postal M-2285 
Teléfonos: 512-8955 512-5121 521-7335 521·1987 Fax 510-0573 512-5121 521-4020AL26 

... 



-~ 

~ 

.3 

3 

3 

3 

~ 

:3 

~ 

~ 

~ 

:3 

~ 

~ 
~-p· 

- ""'··· 
--~--~--~------~-~--~~-------------------- ----~----- --. 

Lab 1: Review 

Lab Objectives 
The purpose of rhis lab is ro give you a chance ro become familiar wirh Microsoiti!> 
Visual Basicr .. programming sysrem. ro see how your computer has been 
contigured. and ro ensure rhar everyone has the requisire base ser of Visual Basic 
ski lis. 

By rhe end of rhis lab. you will be able ro: 

• Add a VBX lile ro a projecr. 

• Add a module ro a projecr. 

• Wrire and call a user-wrirren funcrion. 

• \Vrite :::md calla user-written subroutine. 

• Place comrols on a frame. 

• Load and unload a form. 

• Build an .EXE file. 

• Runa program from Microsoft Windows'" File ;\lilnager. 

• Cusromize AUTOLOAD.MAK. 

Objects and Subroutines 
The panial solurion airead y has rhe form designed. The following controls are 
provided.foryou. '· · ... 

>_:.: ~. '. 
Control nttme 

frmConversion 

t>rJI,Iil<s 

l'(tKilometers 

cmdReser . 

cmdConvert 

frmAbour 

Purpose 

. The primal')· fonn .. 

T exr box for milos 

" . T I!Xt box for k.llometers 

Command buaon ro reset 

Comm:md burton to convert 

The form ro.be displayed \Vhc!n user c~ooses About from 
rhe Help menu 

.. ,,._ .. -, ... 



2 Lab 1: Revlew 

•· 

You will need to add the following controls. The lab instructions will specify 
details; the Iist is just provided here for your reference. 

Control name 

fr.J.Conven 

optEnglish 

optMetric 

spnMiles 

spn!Glometers 

Purpos• 

Frame to hold options 

English to metric option 

Metnc to Englis_h oplion 

Spin control ne:u to miles 

Spin comrol next ro k..ilometers 

The following tu~.ctions are provided for you. 

MilesToKilometers · · 

KilometersToMiles 

Re se tE vef)o'thing 

· Purpose 

Convens miles to ktlometers 

Converts kilometers m miles 

Resets te:tt bo;(es to 0: resc:ts option to English To Metric 

Exercise 1: Reviewing the Solution 
This program converts miles to kilometers and vice versa. The program contains 
nothing that is beyond the class" s prerequisites . 

._ Run the lab solution in \VBL..\BS\REVIEW\SOLl'TIOl'i 

Test the progrJ.m by doing the following: 

l. Type a n\lmber in the :"vliles te.,t box and choose Convert. 

The corresponding numb<r of k.ilometers appears in the Kilometers text box. 

' Click the top portian of the spin control to the right of the :'vliles box. 

The numbering in the Milos box is incremented by 1: the number in the 
Kilometers box :tlso changes. Clicking the bono m portion of the spin control 
decreases Miles. with a corresponding decrease in Kilometers. The spin control 
is a custom control that was added to the project. 

3 .. Click the.spincontrol to t~i:: right of the Kilometers box. 

Nothing should happen. The spin control for Kilometers is disabled when the 
. English To Metric option is speciflcd. 

-'·': .~, j Choose ttí~ Metric To English option and click the Kilometers spin control. 

,.,,· ·"'" '. The appropriate v:tlue is displayed in the :"vliles box. You can also now use the 
:~~_ .. ,;. Kilometers spin control. Thc spin control for :1-liles is disabled . 

• ':: < ~,-. 

·- ·- ·'· .,,, ·.' < 5:. Cho'ose•Reset. · ... . . 
Everything returns to the way it wu whcn the program >tarted. 

6. From the Help menu. eh~ Ab.Jul. 

A form pop> up telling sorncdlin¡ about this program . 

. \\ "hen you"re satistied ) o u know how thc ~r:1m "orks. op~n the project 
PREVIEW.MAK in \VBL.-'IBS\RE.\"IE\\\P.-'IRTIAL a.nd go on to the next 
exercise. 

t 
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Exercise 2: Writing the Application from the Partial Solution 
To save ryping time, the partial solution already has the two forms and sorne 
conrrols created for you. You will need to add sorne controls and add the cede. 

Jllo. Add !he custom control SPIN. VBX lo the project and place two spin controls 
appropriately. 

l. From the File menu. choose Add file. 

~ Locate the SPL'I.VBX file in the \WINDOWS\SYSTEM directory. 

3. Place one spin control adjacent to the :\liJes box, and name it spnMiles. 

4. Place one spin control adjacent to the Kilometers box. and name it 
spnKilometers. 

5. Set the Enabled propeny of spnKilometers to'False . 

... Add the frame with the two option buttons to !he form 

l. Place a frame on the form. and name it fraConven. 

' Explicitly draw the rwo oprion bunons.on the.fram.e. 

Do nor use the double-click method to place the option button on the frame. 
Double-clicking auromarkally P.iacc!s a comi-.ol ori the t"onn, not ~he frame. C\ l!n 
though it may appear mherwise. 

Use the follo" ing names and captions . 

Control name 

frJConvert 

optEnglish 

optMé:[riC 

Control caption 

Enghsh To :\letnc ., . 

1\ktrk To English 

3. Ser the Value propeny of optEnglish to True. 

4. Code the optEnglish_Ciick opticin to disable the spnKilometers control anll 
enable the spnMiles control. 

5. Code the opt~letric_Ciick option to di sable the spnMiles control and enable the 
spnKilo~eters control. , . 

... Add a module to the project 

This module is going ro hold two functions that will be used in the program. 

l. From the File menu, choose New Module. 

2. Choose Save File As from the File menu, move ro the 
C:\VBLABS\REVIEW\PARTI.->..L dirwory. and save 'rhe module as 
REVIEW.BAS. 

... 



4 Lab 1: Review 

~ Write the MllesToKilometers runctlon 

· · This function should accept a single argument named miles and rerum a single-
precision variable that is the value of miles expressed in kilometers. · 

a. Double..:lick the REVIEW.BAS in the Project window to open aCode 
window if it is not itlready open. 

b. With the Code window open. choose New Procedure from lhe View menu. 

c. Selectthe Function op1ion. 

d. Type MilesToK.ilometers in the name box. 

e.· 'ci10ose OK. 

f. Edil the funcü'on as follows: 

M:.l.as':'oK.<.l.c!:'.e~a:-s = :::.J.¡es • :. óC9 

S::.d ?'u..--:.c::.:.:or: .. 

Another way to cre:ue a new function is to just rype the function or subroutine 
heading from anywhere in the code and ¡:-ress E:-.TER. Visual Basic automatically 
e reates lhe new. procedure srub. 

~ Write the KilometersToMiles function 

Perfonn 1h~1 s:ime sleps to create anolher function 1ha1 wi!l convert kilometers 10 
miles. Name lhis function i<ilomelersToMiles.'The formula lo convert kilome1ers 10 
miles is: 

Func:::..o:-. :<!.:o~e::e:-s:'o:·!:..~as (Kilome::e:-:; As S!.::.qle) As S:..ngle 
:<:.:.ome::e:-s:'o:!:..:es" :c:..:ome!:e:-s •. s:z:.;. 

End ?·..:.::.c:::..c::. 

~ On !he form frmConver~ion. code the cmdConvert command 

• In 1he cmdConvert_Ciick funclion. write code 1ha1 determines which option 
bunon has been selecled (!he value of the option bu non will be True if it has 
been selec1ed) and then calls 1he appropriate conversion function. 

··' 
For instance. if,optEnglish is True, then invoke MilesToKilome1ers and s1ore 

. .... the restÍit in lhélxtK.ilomelers box. 

Remember that MilesToK.ilometers retums a number. You need 10 convert the 
number ro a string befare you can assign it toa text box.. 

~. Write the ResetEvery1hing routine 
:·. 't. • • • • 

-' · ·In !he Oeclarntions SeClion for .frmConversion. wri1e a subroutine narned 
.:': ResetEverything thal: •. . 

l. Sets the two lext boxes to "0". 

2. Se1s lhe option English To :'.letric. 

3. Se1s lhe focus to lxlMiles. 

Because this fun.ction is ·necessaiy only on this form. it is most appropriate as a 
fonn-level subrouline. · 

-1. Invoke 1he subrou1ine ReselEverylhing from cmdReset_Ciick. 

-·-·~ 
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Lab 1: Ravlaw 

~ Code the Spin Up Buttons 

Codo the spru'vliles_SpinUp and spnKilometers_SpinUp functions ro nuromntically 
add 1 to the Miles or Kilometers text bo)( and invoke the cmdConv.ert_Click event. 

For example. in spn,\liles_SpinUp you would: 

l. Con ven t'tMiles.Text 10 an integer value using the Val function. 

' Add 1· ro !he resuhs of !he conversion. 

3. Con ven that result back toa string using th~ StrS function. 

~. Assign the new string to txtMi!es.Text. 

5. lnvoke the cmdConven_Click procedure lhat you already coded ro convert the 
value in txtMiles to k.ilometers and.display the results in the Miles box. 

6. Copy this code to spnKilometers_SpinUp. and make the necessa.ry changes. 

~ Code the Spin Down Buttons 

Code the spnMiks_SpinDo~vn and spnKilometers_SpinDown functions to subtract 
1 from the appropriate text box and invoke the cmdConvert_Ciick function. Do nor 
al/o"· rile va/ue in tttMiles or txtKil_ometers 10 fall be/ow O . 

~ Design the menu interface · 

Design the menu interface as follows. 

:\lenu caption N ame 

File mnuFile 

Exit mnuExit 

Help mnuHelp 

AbOUl ... mnuA.bout 

~ Code the menu interface 

lndentation 

Not indented 

lndented once 

Not indemer.i 

Indemed once . ·.' 'f. •'· 

l. Code the mnuExit_Ciick event 10 end the applic:nion. 

' Code !he mnuAbout_ Click evem to load and show the' form frmAbout modh!ly. 
' • : t ' ': ~-. 

3. On the form fnnAbout, you '11 find a command bunon cmdOK. Code that 
command bunon to unload frmAbout. 

~ Set Picture Properties on frmAbout 

5 

On the form fnnAbout. you ·u also find two image comrols: image 1 and imnge2. Set 
the picture proP.,rty of these images to \VB\ICOKS\FLAGS\FLGUK.ICO and 
IVB\ICOi'iS\FLAGSIFLGFR.-\N.!CO. respectivoly. 

~Test your program 

Save and test your program. When you're satisfied it runs correctly. make an .EXE 
file and run it from :he Windo\vs File Manager. Ji you ha ve trouble doing mis. ask 
the instructor for help. lt' s importam thafyou be·able todo ¡bis for sorne of !he 
remaining labs in th< class. 

-;d . _.1 



6 lab 1: Review 

Exercise 3: Optional ... 
l. There's a file named AUTOLOAD.MAK in \VB. lt"s Ün ASCII file and can be 

edited with a simple text editor like Windows Notepad. The purpose of 
AUTOLOAD.MAK is to cause Visual Basic to always include certain files in a 
project. Typically. you'JJ inserta particular custom control in 
AUTOLOAD.MAK. Using Notepad. add this line to the beginning ofyour 
computer's AUTOLOAD.MAK file. 

c:\windows\sys~a~\c~dialoq.vbx 

Then uy New Project from the Visual Basic File menu. and examine the Project 
Window. The version of AUTOLOAD.MAK on your computer may ha ve been 
modified fro'T' the default one installed by Visual Basic. The ddault version of 
AUTOLOAD.~IAK installed most of the custom comrols. Consult the 
documentation for more ways you can customize AL'TOLOAD.MAK. 

~ Add another frarne with two option buttons in it that are Distance and V olume. 
The program currently does only distance conversions. lf the user selects 
Volume. change the titles of the two text boxes to Gallons and Liters. Add two 
more subroutines to REVIEW.BAS to perform these conversions. and cal! them 
from cmdConvert instead of the two you're currently calling. The cmdConvert 
function will ha ve to figure out not only which way the conversion is going 
(English to ~letric or vice-versa) but also which type of conversion is in effect. 
D1stance or Volume. 

The formulas you ·n need are: 

ga~:o~s = ::=e=s .25~23 

:~=e=s = ga::a~s · 3.1853 

3. lf you still ha ve time. extend what you did abo veto de al with mass. The 
formulas yau·n need are as follows: 

90:..:::::s = ~.::~q=a.-.s .4536 

:.C::og:-ams = ~o~:-.::.s • 2..201\6 

~ ·. 

... 
·~ 
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Lab 2: Input V alidation 

Lab Objectlves 
By the end of this lab you will be able to: 

• Use available techniques to verify that the data in the controls is correct ami 
complete. 

• Set the focus back toan invalid control and display an appropriate error 
message. 

Objects and Subroutines 
· The following controls are provided for you. 

Control name 

fnnlnput 

lb!Name 

mslü"fam~ 

lbiSSN 

m.kss¡.; 
\biYears 

m:,kYc:ars 

cmdOK 

cmdCancol 

cmdReset 

lb\Error 

Purpose 

The main inpur form 

Labe\ wirh ~o:Jption ··Same .. 

Masked c:dir comrol for na me 

Label with cap!ion .. SS:-.1 .. 

Masked edir comrol fcr SSN 

La be\ wüh caprion ··Y.:ars" 

Masked edit control fur :eJ.rS employed 

OK button 

Cancel button 

Res.:t bunon 

Label for error mc:ssage 

Pans of the following routines are provided. You· will ha ve to modify the routines. 
The details are in the instructions. · · 

Routine name 

DisplayErrorlabel 

ValidmeOKButton 

Purpose 

Displays an error message in lblError: accepts a string 
argumem: sets lblError.Caption ro the argument 

Determinó when ro enable rhe OK buuon: in\"Ok.ed from 
the Change e\'ent of the masked edit controls 

• 
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Exercise 1 :·Testing the Solution 
This application is a sámple data entry fonn. E:lch control has restricted data. 

Run the completed lab solution in \VBLABS\USRINPU1\SOLU110N. 

When the program begins. you'll see three masked edit controls and three command 
bunons. Test the program by doing thé following: 

l. Type at least one character or number in all three masked edit controls. 

The OK bunon is enabled. 

0 Delete data from one of the controls. 

The OK bunon is disabled. 

3. Try-to type a le_tter in Years Employed. 

An error mess;;ge is displayed. 

~- Type a numbor in Years Employed. 

The error message is cleared. 

5. Try to type more than two digits in Years Employed. 

The appropriate error message is displayed. 

6. Enter data in all the controls. and choose OK. 

The controls are verified and focus is forced to any control that has invalid 
contents. 

When you ·re satisfied you know how the program runs. open the partía! solution 
project in \VBLABS\USRINPU1\P ARTIAL and go on to E:<ercise 2. 

Exercise 2: Declaring the Array 

'· 

• The progr~m uses an arro.y of integers to determine when to enabl~ the OK 
button ~n· .. ,..) Jetemtine whether a ccr~trol is val id. 

• In the D;-:clarations section of the fonn L"'PliT.FR.iv!, declare two integer 
arrays as follows 

Di::~ E:":a!:J:.eO~?laqs {MSi<_COI.r.-rT) 

Di:::t Val~C!la:.a:laqs (:o:!Si<._COUNTJ 

., .... ... .. 

( 

{ 

1 

' 



Exercise 3: Setting Properties 
l. a~ sure you ha ve opened th~ panial solution in 

\VB LABS\U SRJNPlJ1\P . .>..R TIAL 

Lab 2: Input Valldatlon 9 

Note the presence of MSMASKED.VBX in the Project window. The custom 
control has already been added to the project ior you. Three masked ~dit controls 
ha ve been added to the forro. Set the mask property of each of the controls as 
follows: · 

a. Set mask ofmsk.'lame to 25 ampers:llÍds !&l. 

b. S~t mask of mskSSN to ###-##-####. 

c. S~t th~ AutoTab property of mskSSN to True. 

This enables the user to automatically mo' e to the ne~t control when all nine 
úigits of the SSN ha ve been typeú. 

d. S~t mask of mskYears to ##. 

e. Assign O. 1. and 2 to the Tag properties of msk:'iame. n\skSSN. and 
mskYears. respecttve\v. The><! wi\1 be used as subscripts into the 
EnabkOKFlags arra y ·\ater in the application. · .. . 

' Run the application. Try to type in va\ id characters in any of the contro\s. What' 
happens'? 

R~mt!mbt!r. at run timt! J.ny vioialiun of the mas k 1 such as ryping a leuer when 
the mask specities a di~it1 imm~diately invokes th~ V~lidationError event tor 
that parttcu\ar control. You must. however. provide code in the YalidationError 
event ro display an appropriate error message. 

Masks v.ork best for numeric control or for te.xt control of fi~ed kngth. E ven 
thoUgh Name and Years Empluy.:U are nor ti~~d-length comrols. as Social 
Security Number is. masks are u><!ú in this program b~cause the ValidationError 
that occurs when the mask is violat~d is a con,·enient place from which to 
di>play error messages. Th~ Ma.,Length properry of an ordinary text box does 
nothing other than beep. 
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Exercise 4: Displaying Error Messages 

.. ' 

l. Display an error message if the user rypes more that :?.5 characters in mskName; 
clear the error message if the user then presses BACKSPACE. 

a. In mskNarne_ V alidationError event if the StanPosition argument is equal to 
the Maxlength properry of mskName, invoke the subroutine 
DisplayErrorLabel and pass the string "Name limited to :?.5 characters." 

b. In mskName_KeyPress event, set lb !Error Visible to False. You want to 
clear the error message when the user rypes the ne.~t character. 

c. In mskName_Lostfocus. set lblerror Visible to False. 

1. Display and clear the appropriate error message for the SSN control. 

a. In mskSSN_ ValidationError event invoke DisplayErrorLabel and pass the 
string "SSN must b• filled with 9 digits." 

b. In mskSS"l_S:eyPcess event, set lbiError Visible to False. 

c. In mskSSN_Lostfocus event, set lbiError Visible to False 

3. The code to handle displaying and clearing error messages for Years Employed 
lias airead y been provided for you. 

4. Run your program. Verify that error messages are d·isplayed and cleared 
properly. 

... ... 

.·-ry¡.¡;· ....... _ ' ··-,· 
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Exercise 5: 
Enabling the OK Button when Controls are Completed 

The progr:1m uses :m array of integers CEnableOKFlags) to determine when to 
enable the OK bunon. 

l. In the Change event for each of the masked edit controls, invoke the 
YalidateOKBunon subroutine and pass the control name as :m argument. The 
Y alidateO KBunon subroutine is in the .general declarations section of 
INPUT.ffi..\;1. 

" You need to code the YalidateOKBuuon subroutine to check the contents o[ the 
incoming control. set the appropriate flag in the EnableOKFlags ainy to True ir 
the control has data and False if it does not ha ve data. and then sean the entire 
arra y and enablo the OK buuon if allthe merribers of the arra y are True . 

This subroutinc: uses the T:1g property of rhe incoming control as a subscript into 
the arra y . 

a. Assign the value of the comrol's ClipT"t propeny to the variabie 
Te.uWOmask i"Fix #1 ¡ (this will hold the text.without the mas k l. 

b. Con ven the value of the Tag propeny toa number and store it in the \'aMable 
named index I"Fix #::!). 

c. Setthe appropriate member of the EnableOKFiags arra y to-True if 
textWOmask has sorne data :md False if it does not contain data 1 ''Fi~ ;'3 ) .. 

d. Finally, if any one of the three "t1ags" in EnableOKFiags is False. disable 
the OK buuon :md "it the subroutine. lf all the tlags are True. enable the 
OK button t"Fix ¡gl. 

3. Run the appli~ation. Yerify that tho OK bunon. is enabled when all of the 
controls ha ve data. The OK button should be disabled if you then delete the data 
in any of the ..:omrob .. 
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Exercise 6: lf You Have Time ... 
Determining Whether Controls Are Va lid When User Chooses OK 

The application uses an array of imegers (ValidDataFlags) to determine whether a 
control is valid. · 

From the LostFocus evem for each of the masked edit controls: invoke the 
subroutine DeterminelnputValidiry and pass the conrrol name asan argument. The 
DeterminelnputValidiry subrourine sets the appropriate member of the 
ValidDataFlags arra y to True if the control has valid data. 

The OK button will then sean the array ValidDataFlags. set the focus back to any 
invalid control. and display an appropriate error message. You will need todo the 
following: 

l. In the Declarations section of the forrn !NPUT.FR.'v!. declare an arra y of 
imegers named ValidDataFlags. Use the constam :V!SK_COL'NT to size the 
arra y. 

, Invoke DeterminelnputValidity from the LostFocus event of each masked edit 
control. 

• In the LostFocus event for each of the three masked edit controls. cal! the 
subroutine DeterrninelnputValidiry. and in each ease pass the control asan 
argument. 

J. Code the De!erminelnputValidity functioñ to set the flags in the ValidDataFlags 
array. The variable TextWO:Vlask is set for you to contain the text portian 
without the mask of the current masked edit control. Use this variable when 
testing for val id data. 

a. Look at the code in DetenninelnputValidity for Case O. This code has been 
provided for you. Case O corresponds to Name. The code sets the tlag in the 
arra y VaÜdDataFlags to True if the N ame is not null. False if it is null. 

b. Case 1 corresponds to SS:\. Set the flag in the arra y ValidDataFlags to True 
ifthe length ofText\VO\Iask is 9. False ifit's not. 

c. Case 2 corresponds to Y ears Employed. If the value of Year:, Employed is 
between O and 50 inclusi,·e. set the appropriate tlag to True: otherwise. ser it 
to False. · 

-l. Code the cmdOK_Click event to loop through the array ValidDataFlags to find 
the first False inte2er. Then. set the focus to the control that's invalid. If there 
are no invalid con~ols. display a message box stating that all controls are valid. 

5. Test your'application. 
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Exercise· 7: lf You Have Time ... 
l. Enable your users to use the ENTER key to move from one control to the next. !n 

mher words, ENTER and T AB should do the same thing: This requires that you: 

a. Set the KeyPreview property of the form !NPUT.FRM to True. 

b. Write the code in the form's KeyPress evem to detect the ENTER key 
(ASCII 13). 

c. Set the focus to the next conrrol. 

The easiest way to do this is to write a Select Case statement that sets the 
focus 10 a panicular conrrol. The Select Case statemem is based on the va!ue 
of Screen.ActiveControl.Tablndex. When the Tablndex of the active control 
is 1 (that is. the Name control). set the focus to SSN. :VIake a simiiar 
transition for SSN and Years Employed. When the Tablndex of the current 
control is any value orher than 1, 3, or 5. ignore it. 

Don"t torget to consume the keystroke (set KeyAscii to 0) when you do trap 
the DolER key. 

2. Code the application so the user cannot run two copies of it at the same time. 

3. Change the Help forrn to display the program·s name and where it is located on 
the hard disk. 
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Lab 3: Coding for Mouse Events 

Lab Objec'tive 
The purpose of this lab is to add drag and drop capabilities to the BA TCH.XL 
application. A user should be able to dra2 a filename from the file list box to the 
Files 'Tn Print list box. A file icon should-be used when the user is dragging the file 
over" '~rget area. The :-;o symbol should be used when the user is dragging the file 
over a.n area that is not a rarget zone. 

Objects and Subroutines 
The function GetPath is provided for you. This t'unction correctly builds a path. lt 
takes into account whether the current directory is the root. 

Exercise 1: Testing the Solution 
Run the solution in C:\VBLABS\¡'II!OUSE\SOLL'T!ON. 

Draga filename from the file list box to the Files To Print list bo.<. \\lñen you 
release the mouse, the filename is added to the list box. Notice when the file icon 
appears and when the :-<o symbol appears. 

\\lñen you're satisfied you know how the program runs. open the panial solution in· 
C:\VBLABS'u'II!OUSE\PARTIAL and move on to Exercise 1. 

• 

Exercise 2: Adding Drag and Drop Capabilities 
l. You need to add rwo picture boxes to store the icons that will be·displayed as a 

filename is being dragged. The picture boxes rhemselves will be hidden .. They 
will be used only ro hold a file icon and a No symbol. 

.• Add two picture boxes. and name them picNo and picFi!e. 

2. For both picrure boxes, ser the following propenies: 

Autosize = True 
Visible = False 
TabSrop = False 
pic!'<o.Picture = C:\VBLABS'u'II!OUSEU"'O.ICO (No symbo!) 
picFile.Picture = C:\VBLABS\MOUSE\FOLDEROI.ICO (file icon)· 

3. Ser fi!List.Draglcon to C:IVBLABSI,'v!OUSE\FOLDEROUCO. This causes the 
lile icon to be displayed when you ·.!r:!g rhe filList control.. 

-1. To allow programmatic control or· '-~"gging. ser fi!List.DragMode ro Manual. 

lt is better toser Drag~!ode to i\lanual than ro Automatic in this case. lf you set 
DragMode ro Auromaric. dragging begins every time you click the mouse. · 
Therefore, you would not be able ro selecta tilename by clicking rhe filename . 
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5. Because DragMode is Manual. you need to specifically indic:ue when dragging·· ·· 
should occur. 

• In the fi!List_MouseDown event, add the statement fi!List.Drag. 

Dragging always siops automatically when the mouse is released. so you do not 
ha ve to add code to stop dragging. 

6. In the fi!List_DragOver evem and the lstPrint_DrngOver event set the 
fi!List.Draglcon to either a No symbol ora file icon. Add the following code to 
both evem procedures. 

a. When the source is being dragged onto the control, you should set 
fi!List. Draglcon to the file icon. 

. ' 
b. When the source is being dragged out of the control, you should set 

fi!List.Draglcon to the no symbol. You can accomplish this with a Select 
Case statement, as follows: 

Selec~ Case S~a~e 
Case ENTER 'Source is e~~e=i~q ~or.~rol 

!~:Lis:.~raorcon = pic~iie.?~c~~=e 
Case L.ZAVC: · Source is leavi::g c:n:.tro!. 

!ilL~sc.~raqicon = p1cNo.?ic:ure 
::nd Selec: 

ENTER and LEA VE are provided for you in the Declarations section of the 
form. 

í. When the user drops the file in the Files To Print list box. add the file currently 
selected in the file list box to the Files To Printlist box. 

• Add the following statement to the lstPrint_DragDrop event: 

Dlm ?at~ ~S S:ring 
?ath. ,= Ge:.Pa::::-:.1) 

lstPri:u:..AddZ:::e!'l'l Pat.!: ... t'ilLis::.:i!e):a.-:-.e 

GetPath is a function we have written for you. GetPath retums the curren! path 
and correctly adds a backslash if necessary. 

8. S a ve the project. and test your work. 

Exercise 3: lf You Have Time ... 
Changing the Mouse Pointer 

•. When the user selects the Print buuon. set the screen mouse pointer to the 
hourglass. Ha ve it hold that shape for an interval that is a product of the number 
of filenames in the lstPrint control times 1000. Thus five files would mean a 
five-second delay. 

You'll need a timer that is disabled at design time on the forro. In the Print 
bunon, set the timer interval to the value derived in the previous paragraph. 
change the shape of the mouse poimer, and enable the timer. 

Disable the timer and restare the mouse pointer in the timer's event procedure. 
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Lab 4: File Input and Output 

. 
Lab Objective 

This lab is an introduclion co a program mat will ~xcend over several different labs. 
In addilion w tilo-handling smoments. you ·n gec familiar with che program so chat 
in lacor versions you·n s~nd loss lime l~aming where variables are defined and so 
on. 

By che end ofchis lab. you will be able co: 

• Create an applicalion chac reads and wrües data files. 

Exercise 1: Testing the Solution 
This applicalion allows you co open a filo. odie ic. and save it 

Run che solulion in\ YBLABS\FILEIOISOLUTI0:-1. Test che solution bv doing che 
1 1 • • ... 

following: 

l. Open a ti le ([hero should be test filos available in che \VBLABS\ direcmry), 
make sorne changes. and save che tile . 

., Open a file :1gain. make sorne changes. and u:· to (!~'<-it wirhout saving the file. 

The applicalion should prompt you co sav~ changes. 

3. Restan che applicalion. Do noc open J til~: jusc storc cyping text in th.; texc box; 
and then try m exit 

The system should prompt you co sav~ the file and should prompt you for a 
filename. 

When you ·re satisfied you know how che program works. open the panial solution 
in \VBLABS\FIL.EIO\PARTIAL and go on to hercise 2. 

. . 
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Exercise 2: lnitial Setup for the Partial Solution 
Be sure you are in the panial project in \VBLABS\Fll.EIO\P ARTIAL. 

l. The form has alre:ldy been created for you. In the Declarations section, add 
these form-level variables: 

lcv as an integer 

dirtyflag as an integer 

fhandle as an integer 

fname as a string 

Note the constan! declared in the Declarations section. · 

2. You will use the common dialog control to open and save a file. 

a. Add the custom control Cl'v!DIALO<;J.VBX to the project .. 

This control is located in the \WINDOWS\SYSTE:VI directory. 

b. Place this control anywhere on the form; use the default name. 

3. In the Form_Load event, position the form set the \liindowState of the form to 2. 

Note the statément that sets the common dialog control's filter'. lf you wanted 
your text editor to always work with files with a panicular extension, you'd 
change this. 

4. The variable dinyflag will determine whether a file needs to be saved. 

• In LxtEditBox_Change, set dinyflag to True. 

5. You'll want to keep the size of the text box equal ro the size of the form but 
allow room for scroll bars on the text box.'E.,amine the statements in the 
Form_Resize event that do this. 
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Lab 4: l'lltlnput and Outpul 19 

Exerclse 3: Coding the File Open Command 
Code the mnuFileOpen_ Click event to do the following: 

l. lnvoke the File Open dialog box by setting the Action property of the corrunon 
dialog control to 1 (Fix #1 ). 

~ Assign the dialog control's Filename property to fname (Fix #2). 

Notice the code that is provided beeps and exits the subroutine if fname is empty 
(meaning the user didn't selecta filename). 

3. Assign the fonn's Caption propeny like this (Fi.~ #3): 

. f:-:n.'!P3!. Ca;ldO:":. 7' F'or::~.'!'it:la -.. ~ (" ... C:·~ia:og!, Fi.la'!'icla .. ")" 

FileTitle is just :r.: ¡ilename, whereas the Filename property is a fully-qualified 
filename. 

-+. ·Get a fresh value imv mandle by capturing the return value of Free File iFix #4). 

You declared fh:md!e earlier in the fann·s Declaratians sectian. 

5. Open fname far input with tñandle as rhe tile handle JFix ~). 

6.'·'Read rhe file in a single starernent using rhe Input$ staternent (Fix #6). 

7. Ser the dirtyflag to False (Fix #7). 

8. 

The dirtyflag is used ro determine wherher the file needs to be saved befare the 
user can exit. Because assigning rhe file ·s ·contents ro the text box caused a 
change event for that texr box and because rhe Change event set dirtyflag ro 
True. you need to set the dirtytlag ta False. 

Clase the file (Fix #8) . 

·····~~ :~ .,_, 
-. 
' 
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Exercise 4: lf you have time: Coding the File Save Commands 
l. Code the mnuFileSave_Ciick event todo the following: 

a. Exit the subroutine if dinyflag is False. 

b. Open a file for ourpm. 

c. Print the contents of the text box to the file. 

d Close the file. 

e. Set the dinyflag to False beca use the file has just been saved. 

2. Code the mñuFileSaveExit_Ciick event to: 

a. Invoke the mnufileSave_Ciick function. This is e:lSier than duplicating its 
code. 

b. Terminare the application. 

3. To be sure that the file is always saved when the usér tries to exit the 
application, invoke the mnufileSave_Ciick procedure from the forrn's 
QueryUnload_evem. 

Exercise 5: lf You Have Time ... 
l. Add a Save As command to the menu to permit >aving the file under another · 

name. You wam to be able to tell the user if the new name alre:idy exists. The 
function DirS can be used to tell whether a filename airead y exists. 

1. Many editors have a backup feature. whereby the original tile is saved with the . 
extension .BAK. Add a feature to ask the usér immediately befare saving · 
whether a backup is desired or even do it automatically. If the user wants a 
backup. you can copy the original file toa file with the .BAK extension. Do this 
befare you write the rext box back to the original tile. You have ro build the 
backup name yourselfusing string functions. Vi;ual Basic has added a function 
named FileCopy to racilitate doing something like this. FileCopy is equivalent 
to typing copy at the :\licrosoti<!> MS-DOS<!> command prompt. 
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Lab 5: Dynamic Controls 

Lab Objectives 
After completing this lab. you will be able ro: 

• Creare a control arra y. 

• Dynamically add and delete elemems from a control arrny . 

The following controls are provided for you: 

Control name 

t\tEditBox 

Labell 

. Textl . 

Exercise 1: Testing the Solution 

Purpose 

The editing box to hold file 

The label for the buffer 

The paste buiier 

This program is an extension of the simple text editor from the previous lab. The 
editor now has a paste buffer and menu commands to work with that paste buffer. 
Funhermore. this application will permit the user to ha ve up to four paste buffer.;. 
This is where you'll find an array of controls. Each paste buffer is itself editable. 

Run the lab solution in C:\VBLABS\CONTROLS\SOLI.ri10N. Testthe program 
by doing the following: 

. l. From the Buffer.; menu. choose Add to add severa! paste buffer.;. 

~ Open a file. highlight sorne text, and choose Copy To Buffer #l from the Edit 
menu. 

The text is copied to the appropriate buffer. 

.... 3: Try to copy to a buffer that does not exist. 

The.application should beep and display a message. 

When you're satisfied you know how the program works, open the project in 
\VBLABS\COi'<IROLS\PARTIAL and go to Exercise 2. 

• 
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Exercise 2: Setting the Properties 
Be sure you have opened the partía! project in \VBLABS\CONTROLS\PARTIAL. 

• The fonn already has the editing text box. the common dialog control. one label 
and one paste buffer. 

You"ll need to make the labels and buffers into arrays. 

Set the lndex properties of Labell and Text 1 to l. 

Don"t worry about sizing or positioning them; you will take care ofthat in code. 

Exercise 3: Coding the Add Buffer Command 
l. You need a variable to trae k the number of paste buffers. 

• In the fonn"s Declarations section. declare an integer named pastecount. 

2. In the mnuBufferAdd_Ciick event. you need to add a new label anda new text 
box. Add code to do the following: 

a. Load anmher label using pastecount as the inde.~ (Fix #1). 

b. Set the new label's Top 10 its predecessor's Top +DELTA (Fix #1). 

c. Set the new label's Caption to "Paste Buffer if" + pastecount (Fix #3). 

d. Set the new label's Visible property to True (Fix #-+) • 

. e. Load anmhertext box (Fix #5 ). · 

f. Set the new text box's Top to its predecessor's Top +DELTA (Fi.~ #6). 

g. Set the new text box"s Visible property 10 True (Fix #7). 

h. Set the new text box's Text property toan empty string. (Fix #8). 

3. Run the application. and verify that buffers are added appropriately. 

Exercise 4: Coding the Remove Buffer Command 
l. In the mnuBufferRemove_Ciick event. add code todo the following: 

a. Unload the highest label. 

b. Unload the highest text box. 

c. Decrement pastecount. 

2. Run the application. and verify that the buffers are deleted appropriately. 
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Exercise 5: Coding the Edit Menu 
On the Edit menu. there are four copy and four paste menus items. The Copy 
commands copy text from txtEditBox to a buffer. The Paste commands copy text 
from a buffer to txtEditBox. 

The only difference between the commands is which buffer to use. Therefore this is 
an ideal siruaiion for a general subroutine. The subroutine can be wrinen to accept 
an argumem that indicates the appropriate buffer. You will then just invoke the 
subroutine from the menus and pass an imeger to indicate the buffer number. 

For example. from rnnuEditCopy 1 you would invoke: 

::tY_Copy : 

(In the no·.· module you'llleam :;;;,,.,, menu arrays. which will give you a cleaner 
way ot'dr.•c.~ this.) 

You'll hav.: to create the two general subroutines my_Copy and my_Paste. The 
srubs are airead y available in the Declarations section. 

l. !ilsert a cal! to m y_ Copy from each of the copy menu e\'ents. and pass the 
appropriate argumem ( 1, 1. 3. or ~ ). The Paste menu code has airead y been 
provided for you. 

' Add code to my_Copy todo the following: 

a. Check the incoming argument to verify that it' s less than or equal to 
pastecoum. If it's not. beep and issue a message and exit the subroutine. 

b. Verify that Screen.ActiveControl is txtEditBox. lf it's not. issue a message 
and exit the subroutine. 

c. Finally, if everything's okay up to this poim, assign the selected te:u from 
L~tEditBox to the appropriate buffer. The incoming argument tells you which 
paste buffer to use. 

>. Add code to m y _Paste todo the following: 

• Assign the coments ofthe appropriate buffer m txtEditBox.SelText. Again, 
the incomjng argument tells you which paste buffer. 

Exercise 6: lf You Have Time ... 
Write the logic .so that the paste buffen. regardless of how many there are, take up 

_ the ma.,imum amount of room on the right side of the screen. For instance, if there's 
just one paste buffer. it uses the entire risht side. Two paste buffers split the right 
side, three divide it into thirds, :u1d four divide it into fourths. 
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Lab 6: Menus 
. ·, 

Lab Objectives 
After completing this lab. you will be able to:. 

• Enable. check. and hide menu items as needed. 

• Dynamically add and delete menu items. 

Exercise 1: Testing the Solution 
· This application is yet another variation on the multiple paste buffer editor: but this 
time. among other things. the menus change to retlect the number of paste buffers 
available. The previous lab always displayed the same menus. regardless of the 
number of paste buffers. 

Run the solution in 1 VBL-\BSI.\IENUSISOLUTION. and do the followiM: . -
l. Note the appearance of the Edit menu with just one paste buffer. 

~ Add a paste buffer or rwo. and loo k at the Edit menu again! 

3. Load a file. select sorne text in {r. and look at the Edit menu again. 

Cut and•Copy are enabled when sorne text is selected. 

4. Copy something to one of the paste buffers: and look at the Edit menu. 

Paste is enabled if there is something in the buffer. 

5. From the Options menu. choose Use Single Buffer. 

Paste buffer 1 expands. the others disappear. the Single Buffer menu item is 
checked. and the Buffers menu disappears. 

· 6. From the Options menu. choose Use :1-lultiple Buffers. 

This restares the Buffers menu and checks the :\<lultiple Buffers menu item. 

When you're satisfied you know how the application works. open the panial 
project in C:IYBLABSI.\!E.'-I'USIPARTIAL and move on to Exercise 2. 

Tip As you begin this lab. keep in mind one thing beginners ha ve difticulry 
remembering about dynamic inenus in Yisuai·Basic: Typically, it's in the click 
evem of the top-level menu item that you detennine the appearance of the menu 
that is just about to drop down. 
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Exercise 2: Assigning Properties 
' 

l. The fi~t thing to do is to make the three menu items into arrays. 

• In the Menu Design Window. set the indexes of mnuEditCut. mnuEditCopy. 
and mnuEditPaste to l. 

2. The program should sta.rt with the multiple buffer options enabled. 

• In the Menu Design Window, select the Checked property of 
mnuOptionsMultiple. 

Exercise 3: Loading and Unloading Menu ltems 
l. In the mnuBufferAdd_Click event. you need to load not only a text box anda 

label. as in the previous lab. but also menu items. 

• Insert the statement to load an additional mnuEditCut menu item. set its 
caption. and enable it. 

The statements todo the same for mnuEditCopy and mnuEditPaste ar~ 
already provided. Use them as a model. 

, In the mnuBufferRemove_Ciick event. add code to: 

• Un load the highest menu items from the menu arrays mnuEditCut. 
munEditCopy. and mnuEditPaste. 

The statement to decrement pastecount is provided. 

3. Run the application. Verify that when you add a buffer, the appropriate menu is 
added. 

Exercise 4: Enabling and Disabling Menu ltems 

/ 

l. In the mnuEdit_Ciick event you determine whether the Paste. Cut. and Copy 
comm~nds that are visible are to be enabled. 

a. In the tirst For loop. enable a Paste command only if the length of its 
corresponding paste buffer is not O. 

The Len function comes in handy here. 

b. Set the Enabled proPerty of the Cut and Copy commands to the value of 
selectionmade. 

The variable selectionmade has already been set to True or False, depending 
on whether something is highlighted in the editing text box. 

~ . ·' , ·suppose all four paste buffe~ are visible. Then the Edit menu will have 12 
selections (Cut. Copy. and Paste • -1). \\<'hen the userchooses a men'U item that is 
enabled. the Click event for that menu item has an integer as its arg\Iment. You 
can use this integer as the subscript to tell you which paste buffer to work with. 

• In the mnuEditCut_Ciick i:vent. insert the statement to assign the selected 
portian of txtEditBox to the appropriate paste buffer. 

Th¿ ;:~t~ment ro remove the selected text from t~tEditBox is already given. 

The ul:·:; two subroutines. mnuEditPaste_Click and mnuEditCopy_Ciick. 
are t.:u!\.¡Jir.r~d for )'OU. 

3. Run the application. Verify that the Edit menu commands work appropriately. 
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Lab 6: Manua ' 

. Exercise 5: Coding the Options Menu 
1. In this progr:¡m the user c:m specify that only a single paste buffer be used. This 

is done from rhe Oprions menu. Add code ro the mnuOptionsMultiple_Ciick 
evenr ro do the following: 

a. Check whether rhe user has airead y enabled multiple options. lf so, exit the 
subroutine (Fix #l ). 

b. Ser the Checked properry of mnuOptionsMultiple ro True (Fix #2). 

c. Ser rhe Checked properry of mnuOptionsSingle ro False (Fix #3 ). 

d. Ser mnuBuifer"s Visible properry ro True 1 Fix #4) . 

As you switched bmveen single and multiple paste buffers, the rop-ievel menu 
changed from three ro four items. . . . 

The statement that restores buffer O's height ro·IS'?c of the heighr oi the editing 
rexr box is pro,·ided for you. When you r:m the application and selected the 
single buffer option. that buffer expanded ro full height.· Because in this menu 
ítem you're enabling multiple buffers. you need ro shrink buffer O. 

" In the mnuOptionsSingie_Ciick event. add code ro "do rhe following: 

a. Hide the rop-level B~ffer menu by setting its Visible propeny to False. 

b. Un load all paste buffers. their labels and menu items except the firsr. This 
requires th e statements. 

There's J For loop that iterates from 1 ro pastecount ro do this. In ti\'e · 
statemenrs. you can unload textl, labell. mnuEuitPoste. mnuEditCut. and 
mnuEditCopy. Note that unloading menu items makes them in\'isible .. 

The last two S(J(emems of this subroutine are Jlready provided. The variable 
pastecount is S<t to l. and the sole remaining paste buffer is expanded to fuU 
heig:ht. · 

Exercise 6: lf You Have Time ... 
The !Jb solution used Load and Unload when the user added or remo\'ed paste 
buffers. 

However. this is not the most efficient way todo this. When the user adds a buffer 
for the first time. it is necessary ro load that text box. its \abe l. and the Jssociated 
menus. When the user removes a paste buffer or swirches to the single buffer 
option, iris more efficiem ro just hide the control ! ser its Visible propeny ro False) 
than to un load ir. When the user later re-adds a paste buffer. you can just ser its 
Visible property to True. along with its menus. 

Add the logic to make this happen. You '11 ha ve to track not only how many buffers 
ha ve been added. but how many are visible. To keep the problem SJJ1e. remo\'e 
buffers only from the high end. never from the middle. 
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Lab 7: Multiple Document Interface 

Lab Objective . 
The purpose of this lab is to make an applica<ion an :VID! application. This invoh·es 
adding a few lines of code. perionning cenain actions in menus. and sening form 
propenies. 

Ifs important to stress th~c "ne doesn'tjust take an existing Jpplication and 
submerge it inro an ~lDI \Yir.dow in one c!e:.:...'l JperatiOn. In alr.1ost al! c:1.ses. an 
existing application has to be rweaked som;. 

For instance. its menus will ha veto change . ..:nU it may become necessary to make 
sorne form:level variables global. This is panicularly true if you wam your MOl 
application to use a toolbar. 

Objects and Routines 
The following routines are provided for you: 

Routine Location 

SaveCurrentEdiwr MDIChild.Frm 

CloseCurrentEditor lviDIChild.Frm 

CreateNewEdimr MDI.BAS 

. - GetFileName MDl.BAS 

Purpose 

SJves current ~!duor. C.1lk·d 
from ¡,;hilJ' s File! S uve menu 

Closc:s current edimr. 
Prompls ust!r ro sa,·e tile if 
dmyth~ is !lc!t. 

C:llkJ /rom child's File 
Ctv:l.t ·n-::nu. 

Calh:d t'rom Parent"s menu. 
and t.:h1ld"s mcnu. Therefore 
rhis rourinc must b~ global. 

lnvokes common dialog 
comrol to prompt uscr for a 
ti le name. 

CJIIed from Paren< Jnd 
Child · s menus. 

A function - nor a sub 
proccdure sine.: it rerums a 
string . 

. ·~·-~···:1 
- ' . ~ 
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Exercise 1: Testing the Solution 
This program allows you to open multiple dÍlcumems. A new fonn is created for 
each document. The program will prompt you if you attempt to exit without saving 

: changes. 

Run the solution in IVBLABS\:v!Dl\SOLUTION. Test the program by doing the 
following: 

l. From the File menu. choose New Child to open a new child form. Note how the 
menus change when a chi Id fonn appears or disappears. 

' Load severa! child fonns. From the Window menu notice how all the child fonns 
are listed and the current child form is checked. 

3. From the File menu. choose Open File to open a tile .. The common dialog is 
invoked to allow you to select a tile. Open a te<t tile. A new child form is 
created, and the file is placed in the form. · 

-l. Make sorne modifications to the data tile. From the File menu. choose Exit. The 
application prompts you to ;ave changes. Respond Y esto save changes. 

When you're satisfied you know how the program works. open the panial solution 
in \VBLABS\llilDI\PARTIAL and go to Exercise 2. 

Note The solution uses an arra y to keep track of all the child fonns: Each time you 
select File New- a new form is created and the arra y is expanded if necessary. 
\Vhen a form is closed - the array entry is not re-used. In a more robust application 
you could set a tlag in the array if the form were closed and reuse that arra y entry 
rather than expanding the array. · 

Exercise 2: Adding Declaratioris to the .BAS Module 
Be sure you ha ve opened the panial project in \VBL\.BS\1\,lDI\PARTIAL. 

Add the following global declarations in MDI.BAS: 

• Declare a user detined record type named EdR,ecord that contains two fields -
dirtytlag as integer and tilename as string. 

• Declare a global array narned EditorData as type EdRecord. Do not provide any 
dimensions to this array. lt will be resized later. 

• Note the integer declaration EditorCount. 
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· Lab 7: Multlple Oocumant Interface· 

Exercise 3: Creatingthe MDI Parent Form· 
l. You'll have ro creme che parent form from scratch, but chis won't be difficult. 

Most of che work is done by che child form or by che system. so an MDI parent 
form is usual! y trivial. 
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a. Te creare che Y!Dl parent_form. choose New MDI Form from che File menu. 

b. Try ro add anocher MDI form. N atice that che New :VID! Form menu item is 
disabled. 

~ Creare che following menu on che parenr form. 

Y.Ienu caption 

&File 

&Now Child 

&Opon File 

E&xir 

:o; ame 

mnuFi!:! 

mnuFi.ic~'fl!w 

mnuFi!~Open 

mnuFileE.'(iC 

-'· Sét che foi!owing propo:-ties for thé :VrDI parenr r'orm. 

Property 

CJpuon 

~ame 

Scroi!Bars 

Value 

:\!DI Parent 

irm:VID!Parenr 

False 

-+. Place a picture control on che :VID! parenr form. Use che default name. Sét che 
pic:ure control'; Visible propet'!'¡ to False. 

1 A picrure control is che on/v control you can place on an ÑID! pare m r'orm. Its 
sale purpose here is ro provide a place ro put che common dialog concrol. Ir will 
also bé used in che éXtra credit ro add a roolbar.) 

5. Place :he common dialog control on che picrure control. lise che der'ault nam~. 

6. Ser the starrup r'orm ro be frmMDIParenr. 

7. S ave chis form. 

; . .¡: •• 

• Choose Save File A; from the File menu. and name chis form 
:VID IP .-'.R. \IT.FR.'v!. 
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Exercise 4: Adding Code to the MDI Parent Form 
l. Add the following code to the MDIFonn_Load event: 

Sub MOIForm_Load (l 
'Hake che MDI parent as larqe as possible. 
frmMDIParen:.WinCowState = MAXIMIZEO 

End Sub 

2. Add the following code to the mnuFileExit_Click event: 

Sub mnuFile~xi:._Click fl 

Unload Me 
End Sub 

3. Code the File New menu choice to create a new window without opening a file. 
Todo this you can invoke the CreateNewEditor routine and pass a null string. 
The CreateNewEditor routine creates a new child fonn. The CreateNewEditor 
routine receives one argument that indicates the narne of a lile to open. lf the 
argument is null, the routine does not open a file. 

Sub mnuFileNe•..,_C1.ick f 1 
CreateNewEdi:o: 

End sub 

4 Code the File Open menu to create a child window and open a file. Todo this. 
you can invoke the GetFileName function to get a file name and then invoke 
CreateNewEditor and pass the filenarne asan argument. The GetFileName 
function has been provided for you. 

Sub :nnuFileOpen_C.!.ic:< ( 1 
Dirn fn~~e As Strinq 

fr.ame = GetFile~~~e(l 
!f fna~e = ~- The~ 

Exi: Sub 
End !f 

Creat.aNe•.~tEC!. :or :::.ame 
End Sub 
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Lab 7: Multlple Documentlnterlece 

Exerclse 5: Codlng the MDI Child Form 
l. Open rhe fonn fmuv!D!Child. 

~ Ser rhe lv!D!Child propeny ro True. 

3. Code rhe File New menu ro creare anorher child fonn. You can copy rhe code 
from rhe File New menu on rhe parenr ro here. 

4. Code rhe File Open menu ro creare anorher child fonn and open a file. You can 
copy rhe code from rhe File Open menu on rhe parenr ro here. 

33 

5. Code rhe File Clase menu ro unload rhe currenr fonn (UnLoad Me J. This causes 
rhe Unload evenr ro occur. 

6. Code rhe Fonn_Unload event ro invoke rhe rourine SaveCurrenrEdiror and pass 
. rhe form-level consranr DO_Qt!ERY. 

Ifthe "' . .-n·:nt to SaveCurrentEditor is DO_QL'ERY and the diny th·; ¡, True 
for ÜiJS rur"7"., che rourine prompts the user if the tile should be saved and (hen 
saves the :U1! if rhe user responds yes. 

If rhe argumenr ro SaveCurrenrEdiror is :"'O_QL'ERY. rhe routine does not 
prompt the user. it just saves the file . 

- . -
You will invoke Sa,·eCurrenrEdiror from Fonn_UnLoad and from FileSave. 
From Fonn_UnLoad. you do.wanr ro prompt the user. Howe,er. from FileSave, 
you do nOI wanr ro prompr the user. 

7. Code rhe File S ave menu ro invoke the rourine SaveCurrenrEditor and pass rhe 
forrn-level consranr ~O_Q!JERY. 

8. Code the File Ex ir menu ro un load rhe MD!Parenr forrn. This causes all the child 
fonns ro be unloaded and the application to end. 

9. Code the mnuWindow:\linimize_Click routine ro iterare through all forrns and 
minimize any forrn rhat is of rype frmMDIChihJ. 

10. The mnuWindowsResrore cacle has been provided for you. 

11. Open the child forrn'; menu design window and check rhe WindowList propeny 
for rhe Windows menu. 

12. The SaveCurrentEdiror rourine has been provided for you. You may want ro 
review rhe code in rhis rourine. 

Exercise 6: Coding the MDI Child Form: Setting the DirtyFiag 
l. U' data in the rext box control is changed, you need to set a flag. When the fonn 

is closed. the application checks rhis tlag and promprs the user ro save rhe file .. 

In the txtEdirBox_Change evenr. ser rhe dinytlag of the appropriare member of 
the EditorData arra y ro True. The Tag properry of the curre m forrn will .:onrain 
rhe correct indÚ into the array EdirorDara. The Tag property was as;igned the 
appropriare value in the CreareNewEditor rourine. 
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Exercise 7: Coding MDI Child Form: CloseCurrentEditor 
The CloseCwrentEditor routine is a general procedure on the MDI Child fonn. This 
procedure is invoked from Fonn_Unload. This procedure receives an integer that 
indicates wtíich fonn to el ose. The imeger is used as a subscript into the arra y 
EditorData. 

l. Set this fonn·s dirtyflag to False. 

4. Set this fonn·s filename toa null string. 

Exercise 8: Coding CreateNewEditor routine in MDI.BAS 
The CreateNewEditor procedure creates a new child fonn. sets up the array of 
fonns to point to the newly created fonn and optionally opens a file into the te~t box 
on the fonn. 

The first time this procedure is executed. there is no need to creare a new child 
fonn. lt uses rhe child form thar exisred at design time. Remember. when you creare 
an :VID! child fonn at design time you get both a class and one object (an insrance 
of that class). 

The following times this procedure is executed · ir creares a new child fonn. lt then 
checks to see if ir needs to increase rhe size of the arra y 1 it increases rhe arra y in 
increments of :VIA-'<_SIZE. which is currently three). lt increases rhe array if 
necessary and sers the new enn·y in the array to point to the newly created child 

.. form. . .. - .. . ... · .. · ·- ···· · 

Most of this procedure has been provided for yo u. You will need to add rhe 
following statements: 

l. The firsr time the procedure is run • add the staremem to set the array to poinr ro 
the correct child forrn. 

' The following times the procedure is run · add rhe srarement to create a new . 
child fonn and point to ir. 

3. Each insrance of achild fonn own a cell in the global array EditorDara. Set the 
two variables owned by this instance. Explicit direcrions will be found in the file 
at Fix #3. 

4. Set the Tag propeny of the newly created forrn to rhe counter. Remember that · 
Tag is a string. so use the StrS function to con ven rhe counrer. 
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Lab 7: Mu~lple Document Interface 35 

ExerCise 9: lf You Have Time ... Adding a Toolber 
The presence of a toolbar greatly complicates an :O.IDI lpplication. lt's far easier to 
design the application from the start with a toolbar in mind than it is ro add a 
toolbar toan existing MDI application. The major problem is rhat rhe roolbar is part 
of rhe parent form. but rhe data and procedures are partS of the child form. The 
parent does not ha ve access toa child form"s data and procedures. 

Run rhe solurion from \VBLABS\MD!\.XCREDIT. The file folder is for File Open. 
and the diskette is for File Save. · 

lf you wanr to con ven your completed MDI application from the 
\VBLABS'u'VIDl\PARTIAL direcrory to use a tooibar. here·s a li,r ofrhe rhings you 
should do: 

l. Place rwo image controls on rhe picture control rhat' s airead y on rhe :\!DI 
parent. You may either make rhese two conrrols into an array. or lea ve rhem as 
separate controls. 1l1e extrJ credir solution places them into an arra y. The icons 
you will use are \vbliconslofficelfolder02.ico and hbliconslcomputerldisk06.ico .. 

o- Make the picture control visible.(lt's currently invisible. since it only serves to 
hold the common dialog control.) 

3. The code for the ti le open'icon airead y 'xisrs in rhe parent's Open File menu. so 
just cap~ it to tlie click event of the appropnar' image control. 

.J.. The routine SaveCurremEdiror is curremly a fonn-level rouüne on the child 
form. You need ro make ir globally available by placing it in :\IDI.BAS. lt's not. 
enough to just place it there. The routine uses :\le to refer to the current child 
fonn. \\tñen this rourine is no longer a fonn-le\·el rourine. Me is no longer 
available. You must use fnruvlD!Parent..->.cti,eForm in place of :O.le. 

Also. there are several form-level constants that must be placed in :O.!Dl.BAS. 

5. You ma~ now call SaveCurrentEditor from the Save image control'; click e\·em. 
However. you need a means of disabling this control when no child f0rms are 
loaded. There are several ways todo this. but perhaps the easiest is to only 
invoke SaveCurrentEditor if Screen.ActiveForm is of type fnn.v!D!Child. The 
keyword Typeüf will provide this information. 

6. You may want ro place code in the parent's Form_Load event to position the rwo 
image controls. 
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Lab 8:. Trapping Run-Time Errors 

Lab Objectfve 
The purpose ofthis lab is to implemem error handling for the Te~t Editor 
application. 

You will write an application that handles the following two run-time errors:· 

• "Drive nm ready"' -U ser selects a disk drive without a disk . 

• "File too big"-File exceeds ma~imum length of a string (64Ki. 

In this lab, you will focus on the following staterr.ems:. 

Or. ~~~o~ Goco la~e~ 
Or: 2!'"!':1!'" Go=o O 
~es~~e 

~esu:::e ~ex: 

aes;.:..'71e !.aoe!. 

Exercise 1: Testing the Solution 
Run the solution in C:\VBLABS\ERRORSISOLLTION. 

Choose Open from the File menu. and try to open .l file from drive A without a disk 
in drive A. Notice the error message. Place a dis~ in drive A and select Retry. Try 
to open a tlle from drive B without a disk in dri\e 8; this time select Abort. 

There are num<rous files in C:\VBLABS\ERRORS. Thór names indicare their 
lengths. T ry to open each of these tiles, and note what happens. · 

When you are satisfied you undemand how the application works. el ose the 
solution. open the panial solution in C:\VBLABS'ERRORS\PARTI.Q. and 
cominue with Exercise 2. 

Exercise 2: Handling "Orive Not Ready" Error 
In this exercise. you will add error-handling code tu check for invalid drives on the· 
forrn frrnFilelist. 

The partial solution in \VBLABS\ERRORS\P . .>.RTIAL does nm use the common 
dialog control. lf you use the common dialog comcol to open or save a file, you do 
not ha veto worry about handling in val id dri,·e ;~e:itications. The common dialog 
control handles it for you. However. if you had your own file open dialog forrn with 
just the standard Jrive. directury. and file list b<>X'S. you would need to include an 
error-handling routin«! for in\'alid dri\'es. 

·4 

··. 
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Jllo- Enable the error handler in the Orive!_ Cbange event 

l. In the Privei_Change event on the fnnFúeList fonn,.add the following 
statement at the beginning of the rouúne (Fu #1 ): 

On Error GoTo OpenDriveError 

This causes the program to branch to the label OpenDriveError if any run-time 
error occurs during this subroutine. 

2. Place the Iabel OpenDriveError: at Fix _#2. 

3. Place the statement Exit Sub at Fix #3. 

This ensures that you do not fall through and execute the error routine if there 
was not an error. 

Jllo- In the error bandler- Deterrrúne which error occurred and Display message 

• At Fix #4, right after the OpenDriveError label. place the code to determine 
which error occurred. You can do this with a Select Case statement that checks 
the value of ERR 

lf the error number is 68, that indicates a .. Orive not ready .. error. In this case. 
you should display an Abon. Retry or Ignore message box to the user with the 

· message that a drive.is not ready. · 

If the error number is any number other than 68, you should display an OK 
message box indicating ··sorne Other Error Occurred .. and then end the 
program. 

1 'Cecermine che :~:~ 2:=o= 
2 Se lec: Case. E:= 
3 Case 68. 76 • ::>e•rice Una va! !.a;:,:e 

4 mymsq = • ~=!ve Not ReaCy 
S ms¡;type = i\30R'l"~~~Y!GNO?.Z - 'NA.~s:::::~c:·IESS.\GE 

6 msgci:le = ·:>R:vs: 2P-~o:t· 

7 case Else ' A:.y ot~e= e::o: 
8 mymsg = ·so~e othe: er:o: • s::S(:::::l • • • ~ :::::ors 
9 msgtype = OX 
10 msqtitle ~ ·~n~~own ~r~o~· 

11 E;nd Selec~ 

13 
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Lab 8: T11pplng Run-Time Etro11 · 38 

.... In the error handler • Determine how user responded to message 

At Fbt #S, query the value of KeyPressed and take appropriate action. For example, 
if KeyPressed = KEYRETRY (4), you will wanr 10 use Resume. ro retry the 
sraremenr thal caused the error. If KeyPressed = KEYIONORE, you should use 
Resume Ne:rt.lf KeyPressed = KEY ABORT you should set the Orive !.Orive to 
the firsttwo characters of Dirl.Path and use Resume. 

1 . ' Process •.th!c!:. key user pressed 

2 Selec': Case :<eyP:-essed 
3 Case K~'!!tE':'RY 

4 'T::-¿ ac;a!.:t 
S Rest!:r.e 

6 casa ?.:Z'!:~JO?.::: 

7 ·:~o~e. go on ~~ nex: ::.~e 

8 ·~o::a ::!:a:: ::!:e é.:!.ve ::as ::ot :-eal!.y c_hanged 

10 case K:=:-!.;!!:0?.":' 

11 · Ra:ur:: :o prev::..ous dr::..·Ja sac:!.ng & Res\!l:'le. 
12 ::-~·,e:.:lriva = :..et:S(:l!.=!..?a:h, 2) 

?.as~e 

14 Casa =::sa 
15 ·t;::.ex;¡ec:ed key va!.ue 

ló c.y::sc¡ = •t:nexpec::ed res!ll t:S, key = • • St:-S IKey?ressedl 

17 ~s;:::r;:e :.! c~::-:C.\L 

!.9 =.s;::!.:::a = ·KE'! 2:R..tt0?.· 

19 ~s~3ox ~~sq, ~s~~Y?a. ~sq~~~le 

20 ·:::-.c. :~a Appl.:.ca;..:.or:. 
21 ==~ci 

22 E=:.C. s~lec: 

.... Save your project, and test your applicatlon. 

Exercise 3: Checking for "File Too Large" 
There is a limitto how big the string in a text box can be. This is a statement found 
in mnuFileOpen_Ciick of the TextEdit forrn: 

ent.irefile • In~'.J-;S(LOFI!:handlel.f!':.ar:.C.!.e) 

cx:::dicor.~ex: = e~-=~=efile 

When you read a text file and assign itto a text control in this way. there are 
severa! things that can go wrong. · 

The ftrst thing that can go wrong is not a trappable error but is still a problem. The 
biggest ftle that can be placed in a text box and edited is 29.999 bytes. When the 
contents of a·text box exceeds that amount. you won't_be allowed to add any more 
characters. You can. however, browse in thattext box. There is no trappable error 
that occurs when a file of, say. 32,000 bytes is placed in a text box. 

Thus. for files between 30.000 and about45.000. al! you can do is browse. 

i 
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At about 45.000 bytes, when you read the fúe imo the text box as in the sa:atement 
above. you'll get the trappable error"Out ofMemory". The exact size at which this 
error occurs depends on what your program is doing elsewhere regarding variables. · 
Y ou 'U get this error for files up to about 60.000 bytes. 

Between about 60.000 and 65,535 bytes, the statement above generares the 
trappable error "Out of String Space". 

When the ftle size exceeds 65,535 bytes. you'll get error #5. illegal function. This is 
because the first argumem to Input$ cannot exceed 65.535. 

There are numerous files in \VBLABSIERRORS for you to use to observe all of 
these errors and problems. 

In this exercise. you will write error-handling code to deal with all three of these 
trappable errors for the form fnnTextEdit. 

.... Enable the error handler in the File Open routine 

l. In the mnuFileOpenCiick routine on the form frrnTextEdit. place this statemem 
righr befare the call to open the file: 

On ::::o:: Go':'o Ope::.Z:ror 

" At the end of the mnuFileOpenCiick routine. insert this statemem and label: 

E:xi.: S:..:.b 

Ope::..::::o:-: 

..,.. In the Error Handler • Determine which error occurred 

• lmmediately after the label OpenError, install your error-handling code. Your 
code should handle the three errors described above. The necessary constants 
and variable declarations are provided at the top of this evem procedure or in a 
.BAS file. 

1 c;:.:~::z:::-o=: 

2 =::sg::y;~a = RE:'RY'Ci\NC~:. • t·IARNI;.;'G:-!2S3AG2 - SE:CONDS:t;':"TON 

3 rnsq:.:.::!.~ = ·:::.r: s¡:::: SRROR" 

4 

5 'Dec.e:;:ti.ne :~e File E::::or 

7 Case I~~:::GAL_FU~C~:ON_CAL: 
8 myrnsq = "F.:.!e's WA.Y eco b.:.g. • 

9 Case OU':'_OF _ME!iOR':" 

10 .:ny.nsq = "No: enouqr. ;ne::-:c:--.1." 

11 Case ~O_S~RING_S?ACE 
12 my:.,sq = ·ou:: of st::il".g Si)ace. ~ 

l3 Case El se 'Ar.y othe: e::o: 
14 

15 
16 
17 End Selec~ 
18 
19 KeyP:essed = Msgaox(~~sg, ms~~ype. ms~~!~lel 
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Lab 8: Trapplng Aun-Time Errara 

Jlo- In the Error Handler • Detennlne how user responded to message 

• Query the value of KeyPressed and take appropriate action. For example: 

¡ 

2 

3 

4 

S 

6 

7 

8 

3 

:o 

!3 

H 

Salee: Case KeyP:'essed 
Casa K~':'::tY 

Resu.~e 

Case KE:YC.~IC"S:L 

Res~~e :ileTooBlg 
Case E:lse 

''":=-¡ aqa!.!l 

·ca~cel ac:empc co :-ead file 

'::::ex;Jec-:.ed :<ey va: u e 

~y.r.sg = ·ur:.expec:ed :-as:.:.:. :s. :<ey :z • 

::osg:¡"'?e :: CR:':':!:C.;L 

::~s;::.:::d = ·KE:"! :::R?.o?· 

:-!s;3ox :':l'~sg, :nsg::'f'?e. ~s.:;:.:. ::e 
·::::e :~e A~9~:.cac:.o:: 

E::d 
c::-.d se.:ec: 

41 

A simpler way of handling these three errors would bé to just check the value oi the 
LOF function beiore trying w read the file imo the text box. 

Exercise 4: lf You Have Time ... 
You might need to invoke the drive-error-hundling routine from severa! forros. 
lnsteud of including the code directly in the Dri,·e I_Change event. you could place 
lhis code in u general procedure and then cal! that procedure from the 
Drivei_Change evem. lf you ha ve time, modify your upplicution todo this. 

A centrulized version of error handling is provided ,in the 
\VBL-'.BS\ERRORS\XCREDIT directory. Examine the code in Drivd_Change O 
for tile ffiELIST.FRJvl. 
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Lab 9: Dynamic-Link Libraries 

Lab Objectives 
The purpose of rhis lab is ro implemem various Windows API calls. 

Afrer compkling rhis lab you will be able ro: 

• Write :.1:1 Jf:'pllc!!cion that displays rhe WindO\\r'S system pmh. 

• Wrire an applicarion rhar saves informarion roan inirializarion file. 

In rhis lab. you will focus on rhe following Windows API calls: 

• GetWindowsDirectory 

• GetPrivateProfileString, 

• GetPrh·ateProfilelnt. 

• WritePrivateProtileString 

Exercise 1: Testing the Solution for Windows System Directory 
Run rhe solution in \VBLABS\DLL\SOLLTI01\. 

Norice rhe Intormarion menu. From rhe Informarion menu. choose Windows Parh .. -\ 
message box will appear wirh rhe parh for rhe Windows riles. 

When you ar~ certain you undersrand rhe purpose of rhe application. open rhe 
projecr in \VBLABS!.DLL\PARTIAL and move on ro E.,ercise 2. 
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Exercise 2: Getting the Windows Systern Directory 
In this exercise. you will add a menu item to display the path of the Windows files . 

._ Add the appropriate menus lo lhe form frmMPBE 

L Add a menu titled lnformation. and set the name to mnulnfo. 

~ Under that menu add a submenu titled Windows Path; set the narne to 
mnuWinPath . 

._ Declare the APl routines 

You should always copy the declaration from the WIN31.HLP file into your 
application. 

1. Double-click the icon ""WIN 3.1 API Help .. in the VB group to view the help 
file. 

2. Copy the declaration for the GetWindowsDirectory function and paste it into 
the Declarations section of the INIWIN.BAS module. 

3. lf you would like more information about the GeiWindowsDirectory function. 
double-dick the icon ··Win·SDK Help .. in the VB group and search for 
GetWindowsDirectory . 

._ Declare lhe variable lo be used in lhe ..\PI routines 

The GeiWindowsDireclory function accepts a string argument lpbuffer. This is 
the buffer that receives the string indicating the Windows directory. 

• Declare the string as a global variable in the Declarations section of a module as 
follows: 

• In the form load event. fill the string with the null characters 
lpBuffer = StnngS! 255.0¡ 

._ Invoke lhe routine and display a message box with Windows directory 

1. In the mnuWinPath_Click event. add the invocation to GeiWindowsDireclory. 

Pass lpBuffer as the first argument 

The second argument specifies the maximum length' of the buffer. To be sure you 
ha ve enough room for the remmed string. pass 255 for the second argument. 

' Display a message bo' that indicates the Wini.lows path. 

~- Save your project. and test your application . 

.. ·-· --------··---- -- ----- --· --------:-, :: . ..,:::.-:.-'--~·""?·-.-~:'i,.~t:W S iSi tz .rp ·b t¡t?fM§ i8é4$5# 
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Exercise 3: Testing'the Solution
Creating an Application .INI File 

Lab 9: Oynamlc-Unk Ubrarlas 45 

There are many cases where you want to save sorne infonnation between executions 
of an application. For example, if a user moves or resizes a window, you might 
want 10 save the position for use the next time the application starts. The easiest 
way to accomplish this is to creare an application .!NI file. 

When the application ends, you write any inforroation you would like saved to the 
.!NI file. When the application starts. you read the .!NI file and take appropriate 
action. 

In the multiple paste buffer editor. you will record the forro·s position. Each time 
the application starts. yo u will position the forro ro" here,·er the user last leti it. 
You wii11lso add the 2ppropriate number of bufr'ers. 

Run the súlution in \VBLABS\DLLISOLL'TIONII:>.1\VDI.~IAK. 

Resize ahd move the forro. Add two more buffers. From the File menu. choose Exit. 
An .!NI tile should be creared. Run the application again. Notice the forro is 
positioned in the same place and rwo more buffers are added. 

Use Notepad ro view the file.C:\Wl:--.'DO\VS\ED~.L'\1. Notice the infonnarion rhat 
is stored in the lile. 

When you ·re satisfied you understand the purpose of the application. cio>e the 
solution, open IVBLABS\DLLIPARTIALIPINl\\1XMAK. and move 10 Exercrse 
4. 

~-"~ ': '-~l,.H 
. , 

• 
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· Exercise 4: Creating. an Application .INI file 
l. The first step is to declare the API functions in the Declarations section of a 

module. 

a. Create a module if necessary. 

b. Copy the following declarations from the WTI'13.1 API Help file into the 
Declarations section of the module: N atice the declar.uions allow argumems 
to be passed ''As Any"". Remember to use By Val when you invok these 

· procedures. · 

W ritePrivateProfileString 

GetPrivateProfile Int 

~ These functions require arguments that indicate the name of the .!NI tile and the 
narne of a section in the .!NI file. 

The .!Nl filename will be ED2.!Nl. The section narne will be [Te.,t Editor]. 

Declare two global consrams in the Declarations section of a module to store 
these values: 

G:.ooa:. Cons.: ¡:;::::.~;.;;~E = ~::J2. ::-;:~ 

G:.ooa:. Cons:: SEC"::::;~J = "':'E:<':' ::J:'!'Ofl" 

3. In the Form_Unload e,·ent invoke the WritePrivateProfileString to store the 
Top. Left. Width. and Height of the form. This requires. four invocations of 
WritePrivateProfileString. For example. to record the top of the form. the 
invocation willlook like this: ' 

'r'e~? = \oJ:-:.:.eP:-:..va:a?:-o:.:.:.es:::=.:.:'lg(SEC:'!C:-1. :=::Va!. "':'o?·", 

-ayl/al · s:=s ( ::;-::-..:·~?3?:. :-c;ll . ::I::::z:.;.:._::=:¡ 

~. S ave your project at this point. 

5. Test the program. Run the program Move the for.n. End the program. From an 
MS-DOS prompt. view the file C:\WlN1)0WS\ED2.1NI. The file should look 
something like: 

i'!'EXT C:D::"OR} 

To'-'= o 
Le~t;.: O 

Heigh::= nao 
Wid::t= 11:25 

lf the file is not correct. stop now and fix your application befare going on. 

Note Remember, because in va lid calls to APl functions can,cause general 
protection (GP) faults. always save your work beiore testing your application. 
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Once you ha ve cre:ued the .INI file proper!y. you can start coding the 
Fonn_Load event ro read the .!NI file and take the appropriate action. 

In the Fonn_Load evem, invoke the GetPrivateProlilelnt function ro set the 
Top. Left. Width, and Height for the fonn. This requires four invoc:uions of 
GetPrivateProlilelnt. 

U an .!NI file does not exist. ser the Top and Left of the fonn ro O and ser the 
Width ro Screen.Width and Height to Screen.Height. The third argument in the 
GetPrivateProtilelnt cal! is the value to use if the .!NI file was nm found. 

47 

For example, the fol!owing two calls ro GetPrivateProfileint ser the values for 
Top and Width: 

::-:n.."!?92.':'op = Gd:?:-~·ta:e?::o::..le::-.~l32C':':O~. ~':'ap•, 0, r:n::::z::.J.;.: .. s: 
:~ . .'<!P92. :He. e::. = Ge:?:::. va te?.:'of:.: e:.-:.:: S~C':':Q:-J, •:Hdt:::.'", Sc:-ee.":. ;.¡:..:::::. 

7. Save your projecr. and test your work. 

Exercise 5: lf You Have Time ... 
You may want ro expand the application ro also save the number of paste buffers 
that rhe user has opened. Y ou will need ro add another cal! ro 
WritePrivateProtileString in the Form_ünload evem ro srore rhe value of 
PasteColint You "ill al so need ro add anorher cal! ro GetPrivateProfilelnt ro 
retrieve the stored value. Final! y. you will need ro invoke mnuBufferAdd_Ciick rhe 
appropriate number of umes. U PasteCount was stored as 1, you will wanr ro add 1 
buffer. and so forth. 

.lj ·:-·,--, 
1 
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Lab 10: DynaiiÚ:c Data Exchange 

' 

Lab Objective 
The purpose ofthis lab is ro use dynamic data exchange (00E) with Visual Basic 
and Microsoft Excel. · 

In pan 1, you will creare a Visual Basic destination application that links roan 
Excel worksheet. • 

In part 2. you will creare a Visual Basic source application that links ro a Visual 
Basic destinarían application. 

In part 3. you will expand the XLBatch application to be a Visual' Basic destinar ion 
application that uses Microsoft E,,cel ro print a list of selected tiles. 

In this lab. you will focus on the following Properties. Evems. and :Vlethods: 

• . Properties: 

• Evl!ms: 

• Methods: 

LinkTopic. Linkltem. LinkTimeout. Link.\-lode 

LinkOpen. LinkCiose 

LinkPoke. LinkRequest 
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Part 1: Visual Basic to Microsoft Excel· 

Exercise 1: Testing The Solution 
This application links a Visual Basic form to a Microsoft Excel worksheet. The 
application assumes Excel is already running. 

l. Start Excel: open the document C:\VBLABS\DDE\SOURCE.XLS. 

~ Minimize E.,cel. 

3. From Visual Basic, open the solution and run the application 
C:\VBLABS\DDE\VBFROtl-lXL\SOLUTION. 

4. Select the Automatic option. 

The text box should be filled with information from Excel. 

5. Switch to Excel. type som~ new data. and press E:>oTER. 

The Visual Basic fom1 •. ·nuld be automatically updated. 

6. Switch to the Visual 8; fonn. and choose the Manual optioc. 

7. Switch to Excel, and :y;:· .• :w data. 

· 8. Switch to Visual Basic. 

The new data is not ret1~cted in Visual Basic until you choose the Update 
button. 

9 .. From Visual Basic. type sorne new data in the text box and choose Poke. 

10. Switch to Excel. and verify the new data has been recei\'ed. 

\\lllen you are sure you understand the purpose of the solution. clase the project and 
open the panial solution in C:\VBLABS\DDE\VBFROMXL\PARTIAL. 

Leave Excel running and the SOURCE.XLS tile open. 

·-:· 
. )·. 
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Lab 1 O: Dynamlc Data Exchange 

Exercise 2: Coding the Visual Basic Destlnatlon 
Application 
Be sure you ha ve opened the panial solution. 

In this exercise you will create a form with a text box that is linked to a Microsoft 
E.xcel worksheet. The form includes the following: 

• A te.xt box linked toa cell in an Excel worksheet SOURCE.XLS 

• Option buttons to select Automatic or :~<!anual 

• A command button that updates the text box from the Excel worksheet for a 
Manual link 

• A command button that pokes data from the text box into rhe Excel worksheer. 

l. Be sure you ha ve opened the panial solurion in 
C:\ VBLABS\DDE\VBFROMXL\PARTIAL. 

Examine the form YBDEST.FRlv!. 

Observe the existing objects and their given names and propenies. 

Object name 

frmD~st 

tx.tData 

cmdUpdare 

cmdPoko 

opt-\utom:uic 

opr:-vbnuJ.I 

optNone 

Purpose 

Vbual Basic destin:.mon i:o E.'-cel-m:lin form 

Texr bo<t'tO recei\c! d::!u from DDE link 

Burton w requc!st d<!t:l 

Button to pok~ data ro Excel 

Option toser DDE iink m aummatic 

Option toser DDE iink 10 manual 

Option ro terminare link 

' Set the following propenies for the text box "! Form_Load: 

:x:Jac.a.r..i::.:c·o:¡:¡ic = ~:::xcE:.ISOURC::.:c.s· 
e.xt:Ja:a.:...:.::.:.c:e~ = "?.:e:.·. 
cx::Ja:a.~i~k~i~eo~: : 30 

3. Disable the Update button and the Poke b~non at Form_Load. 

51 

4. In the optManuai_Ciick event. set the te<t box Linlú'vlode to manual. and enable 
the U pdate bunon and the Poke button. 

. 5. In·the optAutomatic_Ciick event. set the text box LinkMode to autOmatic. 
disable the Update button and rhe Poke button. 

6. In the cmdUpdate_Ciick evenr updare the contents of rhe text box .. 

i. In the oprNone_Ciick event. set !he link to :\01-<'E. disable the Update bunon 
and Poke button and clear rhe text box. 

8. The code in the cmdPoke_Ciick event h"s alreaJy been provided for }OU. 

Review'the code. 

9. This applicarion assumos that Excel is airead y running and the file 
C:\VBLABS\DDE\SOURCE.XLS is already open. A run-time errvr occurs if 
this is not true. 

When testing this application. be sure you ha,·e Excel staned and the file 
SOURCE.XLS open. 

,. 

• 
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Exercise 3: lf You Have Time ... 
Adding a Picture Box 
l. Add a picrure box to yóur fonn. Set the name to picData. 

2. Set the following propenies for the picrure box at Fonn_Load: 

p~coaca.Li~ode = NONE 
?icDaca.LinkTop~c = ~~~CELICHARTl.XLc• 
p~cData.Linkitem = ·chart• 
~icaaca.Li~~Timeout = 30 

3. If the user clicks the Manual option. set the Link.\<lode for the picrure box to 
MANUAL. Remember to set LinkMode to :-IONE before setting it to 
MANUAL. 

~- If the user clicks the Automatic option, set the Link.\lode for the picrure box to 
AUTOMATIC. 

5. lf rhe user clicks the Update bur. ::. ''xecute a LinkRequest to gct the new data 
~ · .he picture box. · 

6 .. ~<.J a command button that will al!ow the user to end the application. 

7. To clear the picture box when NONE is selected. use picData.Picture = 
LoadPicture () 

8. To test this application. you need tostan Excel and open the chan 
CHARTI.XLC file. You will find this tlle in C:\VBLABS\DDE. 

9. Once Excel is running and the chan is open. run your application . 

... -- .7"-· - ····-~·-· 
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Part 2: Visual Basic to Visual Basic 

Exercise 1: Testing the Solution 
This application links a Visual Basic form with another Visual Basic form. 

l. Open the proj~ct DDE-S.MAK in CIVBU.BS\DOE\VB2VBISOLUTION and 
make an executable. 

From Program Manager. run the Visual Basic source application 
G:IVBLABS\DDE\VB2VB\SOLUTIOl'o"\DDE-S.EXE. Choose the Source 
option so the application will actas a source. :Vlinimize the application. 

° From Visual Basic. open the project under 
C:IVBLABS\DDEIVB2VBISOLl!TIO~"\DDE-02.:VlAK. and run it. 

Choose the .-\utomatic option. The form should recei\·e information from.the 
other Visual Basic application. 

When you are certain you understand h.ow the application works. open the partial 
solution for the so urce application in C:l VBL.-'.BS\DDEI VB2VBIP.-\RTI-'.L. and 
ffiove on ro Exercise 2. 

Exercise 2: Coding the Visual Basic Source Application 
In this exerctse you wil! creare two Visual Basic applications. One wil! be the 
source application and one will be the destination application. 

Be sure you have opened the partial solution in 
C:l VB LABS\DDEI VB2VBIPARTL-'.LIPDDE-S.:V!AK. 

1. Examine the form. DDE-S.FR.\1. Observo the e.,isting objects and their given 
names and properties. 

Object 

frmSourc.:e 

l'USource 

cmdDone 

optSource 

opu'lone 

Purpose 

Vi:)ual Basic ::;ourc~ rOrm 

T ex.t bo., to Jet as ..;o urce in DDE link 

Command to end the u.pplic:uion 

Opc:ion m set the Jpplication to act as a source applic:uion 

Opc:ion to cancel the DDE conversation. 

The constants NONE. AUTOMATIC. :'>1.-\~"UAL. and SOURCE are provided 
as form-level constants. 

o· Set the Link.vlode property of frrnSoorce to Source. This is required at design 
time in arder for the applic:ltion to be a DDESource. 

3. Code the Source option bunon to: 

a. Clear any previous server link. 

b. Set the source LinkTopk of th~ for:n to ""lcmSource"". 

~- Set the LinkMod~ of the form to SOL'RCE. 

-l. Code th~ None option buuon tu d<:u :!tiY existing lini<>. 

5. Run your application ro be .ure it .:an .:ompik ar.d «~cut~. 

6. Mak~ your source applic:llion into ltl .E.XE .:olled DDE-S.EXE. CYou \\il! use 
this name in the client appliC:ltion. t 

.. 
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Exercise 3: Coding the Visual Basic Destination 
l. Open the project, PDDE-D2.i>IAK. 

~ Examine the single form of this project. 

Observe the existing objects and their given names and properties. 

Object Purpose 

frmDest 

txtOest 

cmdUpdate 

optAutomatic 

optManual 

optl'ione-

3. Code Form_Load to: 

Visual Basic destinarion form 

Tex.t box m ser..-er J.S destination link 

Command to updat~ the contents ofthe text box 

Oplion to set the DDE link m autom::nic 

Option to set th~ DDE link to manual 

Option to terminare the DDE link 

a. Set !X!Dest.Link.lvlode to NO!'<"E. 

b. · Set !X!Dest.LinkTopic to the name of the source application plus the value of 
the LmkTopic in the Visual Basic sou.rce ¡··oDE-SifnnSource""). 

c. Sét txtDest.Linkltem to the name of the text box·on the source ("txtSource"). 

d. Set txtDest.LinkTimeout to 30. 

-l. All code for the option buttons and the command bunons is airead y provided for 
you. Examine it to see what it does. 

5. Make your application into an .EXE named DDE-D:!.EXE. 

Exercise 4: Testing Your Applications 
l. Run your source application. Choose the Source option befare cominuing. 

, Run your destination application. Yerify that yourdestination application can 
recetve and send data to the source application. 

( 
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Part 3: Microsoft Excel Batch Print Utility 

. Exercise 1: Testing the Solution 
This application implemenrs the Prinr bunon in the BA TCHXL application. The 
application uses Microsoft Excel ro print a group of files. The solution 
automatically starts Excel if necessary. The solution sends Print statements ro 
Excel ro prinr all the files in the Files To Print list box. Test the solution: 

l. Clase Microsoft Excel. 

2. Run the solution in C:\VBLABS\DDE\BATCHXL\SOLUTION. 

a. Place severa! XLS tiles in the Files ro Prinr list box. Sorne .XLS tiles can be 
found in C:\VBL\BS\DDE. 

b. Place only XLS tiles in the Files To Prinr list box. lf you try to print any 
other rype of tile. Excel will send back an error message. 

c. You may need ro use the Windows Control Panel ro ser your primer ro Fll.E 
if there is no primer available in class. 

d. Choose the Print button ro cause the Print command ro be S<nt ro Excel. 

When you are cettain you understand how the program works, open the panial 
soltition in C:\VBLABS\DDE\BATCHXL\PARTIAL. 

' .;:~ ... ·.' 
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Exercise 2: Coding the BatchXL Print Command 
Be sure you ha ve opened the partía! solution in 
C:\VBLABSIDDE\BATOL'G..IPARTIAL. 

l. Add a form-level string variable narned ExcelCmd. Note the constants that have 
been provided. 

2. Add a text box to the BATCHXL.FR.'vl. Set the following properties: 

Name = ~x~~:ccen 
Vis1ble ::r. ::a:se 

3. Code the Print button (cmdExcel_Clickl to: 

a. Set txtHidden to be the link to Microsoft Excel. Set the following properties 
of txtHidden: 

LinkJivlode = NONE 

LinkTopic = '"ExceliSystem'' 

Link..'vlode = MA.'IUAL 

No Linkltem is needed. because we only W"l.i •o link to Excel for 
Link.ExecUles. not data exchanges. 

b. Code the three command strings and send them to Excel by means of 
LinkE.,ecute. Remember the ftle name will need to be in quotes: You ·n need 
the four qumes to equal an actual quote in the final string. For example: 

Di::: Q a3 5~:::-:.::; 

D::.::-. :::a:::e .:l.s 5;::::-:.::g 

Q = C.-:=5(3~1 '7:-.::.s is :~e cr..:.o:e sy:;-bo;. " 

Exc-a:.c::-C. ="lO?::;:;¡·- Q- :::.a:::e- Q- ·.::.)]" 

The other commands will need ro be created as follows: 

t?~.::·i:"i.:. ... :.. :.:...:.s:::. :.;.:.:;:::,: .:.;:s:::. :1: 
(CLOS:::!?.~.:.,;::;¡: 

c. Place <= = ooE••eo:s < 1 after each LinkExecute connmand. 

d. Set the LinkErrorTimeout to 30 seconds for the Open and Close commands. 
Set the LinkErrorTimeout to 60 seconds for the Print command. 

e. Change Screen.:VIousePointer to an hourglass while printing and back to 
normal when done. lnsert these two statements at appropriate places in the 
event procedure. Use the constants DEFAUI..Tand HOURGLASS. 

4. Termínate the DDE link when the ftles have printed. 

5. Display a message box when all files ha ve printed. 

Exercise 3: lf You Have Time ... 
Handling a DDE Run-Time Error 
Verify that Microsoft Excel is staned bdore trying to print. If it is not. you will get 
the following nm·time mor: 

Ask whether the user wants Excel started (YESINOJ, Handle user responses. 

""" .... ~ : ........... - -.. . 

• 
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Lab 11: Object Linking and 
Embedding 

Lab Objectives 
. Th~ purpose of this lab is to writ~ an application that can send and retrie,·e data ro 

and from :1-ficrosoft Excel. The progrJm is a variation on the DDE lab that did the 
same thing. except that tt uses DDE instead of OLE. 

Your form should look like this: 

1 '----~ 

Exercise 1: Reviewing the Solution 

.... Run the lab sólution in \VBLABS\OLE\SOLUT!Oi'i\OLERW.ii<L-\K 

Test the program by doing the following: 

l. Choose th~ Stan Excel button. 

¡,;!icrosoft Excel is start~d. a workbook is opened. and Microsoft Excel is 
minimized 

~ Choose the Get Data bunon. 

The value of cell A 1 is pi leed in the te.~t box. 

3. Modify the value in the text box and choose the Send Data button. 

-1. Switch to Microsoft Excelto verify the new data in A l. 

When yo u· re satistied that yo u know how the progrJm works. start a new project 
and go on to the nl!."\t c!XI!rcbe. 

-, 
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Exercise 2: Writing the Application 
l. Design the form as shown in the previous diagram. 

~ Save the form and project in the directory IVBLABS\OLE. 

3. Cede the Open button to: 

a. Load Microsoft Excel 

b. Open the workbook C:IVBLABS\OLE\SOlJRCE.XLS 

c. Select the worksheet SOliRCE 

Note If you ha ve time. code the application to start :V!icrosoft Excel only if it is not 
already running and open the workbook only if it is not airead y open. 

5. Cede the Get command bunon to retrieve the value from ceil A 1 imo the text 
box. 

6. · Cede the Send command bUL:.;n to send the value from the text box to ceil A l. 

7. Test the application. 

Exercise 3: Optional... 
1. .-\ well-behaved program should leave the computer in the same state as when 

the program began. That is. you should el ose Microsoft Excel .if you started it 
and close the workbook if you opened it. Add the code todo this. 

, Create functions for starting Microsoft Excel. for determining if a workbook is 
open. and for opening a workbook. Make these functions generic.so they can be 
used in other OLE programs. This wiil require passing argumems into the · 
functions. 

.. --·--.. ----------··:----------.-.• -.• -•• ~ •• ,._,...··;;¡J;""Jl2tí"""" 

¡ 

t 



"·'''"-'' ------

Lab 12: Data Access Using the 
Data Control 

Lab Objectives 
In rhis lab you will write an applicarion rhar displays data from rhe B!Bl!O.:VIDB 
darabase. The BIBLIO darabase is a sampíe darabase rhar ships wirh Visual Basic. 

The BffiLIO darabase has rhe following rabies: 

Authors 
Au_ID 
Aurhor 

,.,Tilles 
' Tirle 

Year Published 
Au_ID 
ISBN 
Pl.;'BID 

Publishers 
PCBID 
N ame 
Company N ame 
Address 
Ciry 
Srare 
Zip 
Telephone 
Fa.' 

Publishers Comments 
PUB ID 
Publisher 
Commenrs 
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Exercise 1 
l. Creare an application that displays the title and author from the BffiUO.MDB 

database. The BIBLIO.MDB database is in the VB directory. 

Include Move bunons to move first. last, next and previous. 

lnclude a Find command bunon to find a particular author. 

~ You will need ro jo in the authors rabie and the titles table ro get the author and 
rirle. Todo rhis. ser rhe RecordSource property of the data control as follows: 

oacal.Recordsou:ce = ·selec: aut~or. t~~:e :ro~ a~~~ors. cicles 
-·,...he.:e authors.au_:.c. = :.:.:l.es.au_id" 

3. The application should look as follows: 

Tille: 

Author. 

Next ¡j 
j Previ'?u~j 

1 First !l 
j. Last. íl 
j Find !l 

IKJI<l t!IEZ'.a1l>l N 
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Lab 13: Data Access U sing the 
Data Object Variables 

Lab Objectives 
In this lab you will write an application that Jisplays authors and titles from the 
B!BL!O.:-..IDB database. 

For each author. \\e \\ant to see a list bm that contains all the titles written by that 
author. 

You will use the object variables Database and Dynaset. 

Your form should look like this: 

. 1 Fo•l 11 Ned• Laot 

~ ' '"• ~: .~'- < ._ 
· Author Author ID · 

Tilles 

The lo41CIOsolt V11udl BasiC ..o1k:hop j 
The lrol•c•osoll lllsu.alllatiC lor MS-005 wo•kshop ¡ 

-~- 1 
L-----------------~--~ 

1 Load o ....... , >r¡ ~---E ... ---__,r· 

Exercise 1 - Testthe Solution 
l. Open the solution in C:\VBLABS\DATA21SOLUTION. 

' Choose Load Database to load the úatab:ise. 

J. Choose :-ie~t to move to the next record. 

-l. The titks for each author are- úisplayeJ in a list box. 

. ' ; ~-

• ¡ 
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Exercise 2 - Display the Author and Author ID 
To make things simple, st3rt by just displaying the author and author id and gening 
the buttons to work. In the next step. you can add the title infonnation. 

The fonn lÍas been designed for you. No code has been provided. 

l. Open the panial solution C:\VBLABS\DATA2\PARTIAL. 

2. In the general declarations section, declare a Database variable anda Dynaset 
variable. 

3. Code the cmdloaddb_Click event to: 

Set the database variable to C:\VB\BIBUO.:VIDB 

Create a Dynaset that contains the author and au_id from the authors table. You 
can use the following SQL statement to create the Dynaset: 

Selec: Aut~or. Au_ro ~~om ~u:ho=s 

Display the first record. 

4. Code the First. Next. Previous and Last command buttons to move through the 
Dynaset and display the infonnation in the text boxes. 

5. Code the cmdEnd button to end the application. What do you rieed to clase 
befare ending the application'? 

6. Run your application and make sure it works correctly. 

• 

• 
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Exercise 3 - Display the Titles for Each Author 
Now, let's display the titles for each author. 

The tides are in the Titles table. You will need a separ:11e Dyanset variable to hold 
!he title inforrnarion. · 

l. In the genero! declarations seclion, declare ano!her Dynaset variable. 

' Creare a genero! procedure that creares a Dynaset of titles for a particular 
author. You can use the following SQL statemem when creating !he Dynaset for 
the rirles: 

This procedure should a!so loop through the titles Dynaset and copy all of the 
ritles tO the btTitles list box. · 

3. lnvoke the general routine you jusi created from each of the move command 
bunons. 

4. Tes~ your applic:uion. 

Exercise 4- lf You Have Time ... 
Code the Solution using Snapshot and Filter 

Another way ro salve this progrom is ro creare a snapshor of all the titles when the 
database is loaded. Then ser the Filter propeny to display only the tilles for a 
panicular author. :\!odify your progrom to use this method. 

A solution has been provided for you in 
C:l VBU.BS\DA T.\21.\:CRED!T\SOLL 'TION. 

l. In the generJI declararions seclion of the forrn. declare two snapshot variables. 

2. In the cmdloaddb_Chck event. se1 a snapshor variable 10 comain all of 1he lides 
from the lides table. 

3. In the general procedure 10 get 1he lides: 

Se1 the fi!ter property for the snapsho1 variable w specify only 1he litles for the 
currem author. 

Creare another snapsho1 based on the firsl snapshot. 

Copy al! rhe 1itles from the ti11ered snapshot to !he lstTitles lis! box . 

4. lnvoke the genero! procedure rrom e:~eh of the move bunons. 

5. Test your application. 

' . 

!: zry~ 
'j 
·' 
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Lab 14: Adding Online Help 

Lab Objectives 
Tho purpose of this l~b is to add online holp ro a Visual Basic application. 

Thore are four <reps in adding Help toa Visual Basic Application: 

1 .. Creare the .RTF tile. 

2. Create the help projoct t.HPJ¡ file. 

Assign tht! comext numbcrs. 

3. Compile the .RTF fiks by passing the .HPJ tho tirst command line paramor<r to 
the Help compikr . 

...¡., Creart! the Visual Bask ¡)rogram. 

Assign the HelpContextld properties ro the appropriate context riumbeis. 

· Assign the HelpFile:"iame property to the application. 

Help will be invoked automatically when the user presses Fl. 

If you want to in\'oke Help explicitly. you can use the common dialog controlor 
call the WinHelp Windows API function . 
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Exercise 1: Creating the .RTF File 

•.· 

The .RTF file is the file that contains the actual help text. This file.can be cre:ued in 
any word processor that can save files in rich text format. 

The easiest way to create the file is to"use the Windo,.;s Help Authoring Templ:ue 
(WHA T.DOT). The Windows Help Authoring Template makes cre:uing help files 
easier by providing dialog boxes and macros to enter help fearures that would 
normally be entered using specialized help coding and arbitrary word-processing 
functions. For examp,le. instead of typing footnotes for a topic"s context string and 
title. you can simply type the information in a dialog box. 

In this exercise you will use Microsoft Word for Windows and WHA T to create a 
simple help file. The help file will have an index page with two jump topics and one 
popup defmition. 

... Create a new document based on the WHA T6 template. 

l. Open Word for Windows. 

2. Frorn the File rnenu. choose :\ew. 

3. From the ternplate list, choose WHA T6. 

Sorne new options are added to the Insert rnenu to assist with creating the help 
file. You are now working on Docurnent.:! . 

... ·Inserta new topic named GE:\_TOPIC 

· 1. Frorn the insert rnenu. choose Topic. 

' Fill in the Topic tableas follows: 

·a. Title: 
Context String: 
Keywords: 

General Information 
GEl\_TOPIC 
General:lndex 

b. Check the option ··Place new topic at end of file"' 

b. Choose O K. 

The topic is inserted. You should now see: 

S.#.K <paragraph rnarker> 

You should be on a line that has style Heading 9. You would insert text as 
Heading 9 ifyou wanted sorne See Also topics under the main heading. We 
are not adding those. 

Press enter to start a line as style Normal. 

If the paragraph mark is not visible. select the paragraph symbol in the 
upper-right comer of the toolbar. 

3 .. In the document. type the text for the tapie as follows: 

This is the ge~eral information. This is the lirst page of Help that the user 
wlll see when they call Help from my progr'am. 

4. Press E:O.iTER to start a new line. 

;• 

·. 
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~ Add a Jump to COM_TOPIC 

l .. From the Insert menu. choose Jump or Popup Hotspot. 

~ · Fill in the Topic tableas follows: · 

Text: List of Commands 
Conte.<t String: COM_ TOPIC 

3. Be sure JUMP is selected . 

.J. .. Choose O K. The jump emry is added to your document. 

5. Press E."TER tostan a new line. 

~ Insert the tapie for COM_ TOPIC 

l. From the lnsert menu. choose Tapie. 

, Fill in the Topic tableas follows: 

Tttle: List of Commands 
Context String: COM_TOPIC 
Keywords: Commands 

3. Choose OK. 

The topic is inserted. 

.+. In the document press enter to start a new line with ;tyle Normal 

Then type the text for the topic as follows: 

This information is displayed when a user selects List of Commands 
from my help file. 

5. Press E:-. TER tostan a new line. 

~ Include a popup on this topic 

l. In the document type the text: 

Here is a de!inition of 

2. From the Insert menu. choose JÚmp or Popup Hotspot. 

Text: 
Context string: 

3. Seléct Popup . 

4. Choose OK. 

multitasking 
WORD_TOP!C 

The popup entry is inserted in your document. 

· 5. Press E:-. TER to stan a new line. 

~ Insert the topic for WORD_TOP!C 

l. From the !nsert menu. choose Topic . 

2. Fill in the Topic tableas follows: 

Title: multitasking definition 
Context String: WORD_TOP!C 
Keywords: multÚasking 

3. Choose OK 

The WORD_TOP!C is inserted. 

• 
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4. In the document, press en ter to start a new line styled as Nonnal. 

Type the text for the topic as follows: 

This infonnation will pop up when the user clicks "multitasking". 

5. Press ENTER to start a new line. 

~ Save tbe file and close Word for Windows · 

l. Save the file as C:\VBLABS\HELP\HELPI.RTF. Be sure the save file type is 
RTF. 

2. Close Wórd for Windows. 

Exercise 2: Creating the Help Project File 
~ Create tbe belp project file: 

Y ou can e reate a help project file using Notepad. 

l. Open Notepad. 

' Create the .HPJ file as follows: 

¡::-::..:::s¡ 
!:¿1.;>:.::: 

C0:1_-:'0PIC 2 

~·JO::t!J_"!'O?!C J 

3. Save the file as C:\VBLABS\HELP\HELPI.HPJ .. 

Exercise 3: Compile the Help.File to Create the .HLP File 

~ Compile the help file 

To compile the help file. from an MS-DOS prompt type: 

C:> \'J'9t.A3S\HSL? 

HC? H.C:!.?l.H?.; 

The file HELPI.HLP is created and saved in C:\VBL-\BS\HELP. · 

Exercise 4: Testing Your New HELP File 
Bdore using the help file from Visual Basic. you might want 10 just run WinHelp 
against the help file and verify it was created correc!ly; 

l. Choose Run from the Windows Program l\lanager File menu, and type 
WL'IHELP. 

' Open your help file C:\ YBLABS\HELP\HELP I .. HLP. 

Test your help file connections between topics. keywords. and popups. 
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Exercise 5: Creating the Visual Baslc Program 
l. Stan Visual Basic, and place three text boxes on a fonn. 

2. Assign the HdpContextld property foreach text box ro 1,1. and 3, respectively. 

3. From the Options menu, choose Project. Assign the HelpFileName 
C:\VBLABS\HELP\HELPI.HLP. 

4. Run your application. 

5. Press FI from each of the text bo.<es. Notice how Hélp is automatic:llly invoked 
with the corree! conte.<t number. 

· Exercise 6: Calling WinHelp from a Visual Basic Program 
Visual Basic automatically invokes Help for you when the user presses FI. lf you 
want to invoke Help at mher times. you can explicilly cal! WinHelp. In this 
exerci;e, you will create a Help menu wi,th three submenus. The tirst submenu will 
display the index page of your help tile. The second submenu will display Help on 
"wmmands" and the third ,ubmenu will di; play help on the topic 2. 

l. Add a Help menu with two submenus named lndex and Search respectively, 

.., .-\dú rhe following declar.uions toa module of;. our Visual Basic program: 

U~c:.a:-~ :·.::c:..:..o~ ·:1:..:-.:!elp r.i;, ·use:-· (3y'.'a: ~~·;:".d. _;s !:!".-:eqe!", 

3:¡'/a:. l;n-:e:.;:::.:.e .:O.s 5':.:-:.n<;. Sy'ia.: ·....c:;:-::-a::¿ .l.s :r:.r.aqe:-. 
- ¿-,...i)a:.a As .::..::y) .\s :r:.:.eqa!' 

'Eel? Co::sr.a::.::s 
c:.:-.s: :;:.:::?_ce~::-.:::-::- = &.~1. 
C?~S: EE:?_~~::' = &.E~ 
C;::::.s: ¡.::::? _c::::-E:-l':'S = s.:n 
Co:-.;;:. ~E!.?_?_:._';_:-:.;:.:-:=:·! .:z .áH:OS 

D:..~.=c As :~:~ge: 

:;,:,::'1 Saa:-ch .l..s 5:=:..:'l.q 

':'0!:-:-::..:-.a:a Ee:.;> 

. J:..~?:.3.':' :.:--.¿::!:.0:: 

·e~:.:. =~• 3ea=c~ d:1:..~a 

Co~s: ~elp::.l~ = *C:\V3~S\HE~?\HZ~?:.~:?M 

3. From the lndex menu cornmand. invoke the WinHelp function to get the 
contents of your help tile. 

4. From the Search menu collli!Wid. invoke !he WinHelp function to execute a 
,• 

search in Help. 

Saa:-:::~ = M:r.•..!: ::!. -:as!::!.::.Q• 

r:: = ':I:.::.He::;> ¡ :o::;~l. ~·.n-..c!. Ht:Pr::!. E?::.?_?.;~:-:.;:::::::·!. ayva:. sea:.:-::.1 
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You could also program the Search menu to search for a selected keyword as 
follows: 

If TypeOf ~creen.ActiveControl is Textsox ~hen 
Search == S creen . .\c:ivecontrol._ S el Tex: 

El se 
search = ·contents• 

End If 

Exercise 7: lf You Have Time ... 
Using the Commón Dialog 

.. ,. 

Use the common dialog control io invoke Help. Refer ro rhe Srudenr Workbook for 
examples. 
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Optional Lab 15: Creating Graphical 
Effects 

... 

Lab Objective 
The purpose of this lab is to implement gr:>phics in a Visual Basic application. 

In exercises 1 A and 1 B. you will create a gr:¡ph using the GRAPH.VBX custom 
control from the Visual Basic Professional Edition. 

In exercises !A and 28. you will simulate a 50 bunon control with a bitmap. 

Exercise 1A: Testing the Solution-GRAPH.VBX 
Ruri the solution in \VBL\BS\GRAPHICS\GR..>.PH\SOLUTION. 

When yo u are cenain you understand the purpose of the appHcation. open a new 
project and move on to the next exercise. 

Exercise 18: Usino GRAPH.VBX 
. -

In this exercise you will create a graph using GR.->.PH.VBX. You will create a 3-D 
pie chan. 

In this loo. you will focus on the following Objec<S: 

GRAPH.VBX 
.Dr:>wMode 
.NumPoints 
.GraphType 
.Gr~phStyle 

.GraphTitle 

.GraphData 

l. Stan a new project. Add the GRAPH.VBX custom control to the project. Visual 
Basic automatically stans a graphics server when you add the graph control toa 
project. 

2. Sel<ct the graph icen from the toolbox, and draw it on !he form. lt creates a 2-D 
bar chan automatically using five ranJom data points. This assists )OU in seeing 
the graph type and style with which you are working. 

3. Tu see more than fi,e points, change the :"umPoints propeny. Set :-iumPoints to 
6. lt "ill now generate the e han using six random data poims . 
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4. Change the type of graph to a 3-D pie chart by changing the GraphType 
property. You will now see a 3-D pie chart of six raildom data poims. 

5. Change the style of the graph to% Colored Labels by changing the GraphStyle. 
This will place colored labels of percentages on the chart. with lines. 

6. Add a title "My First Pie Chart'' to the Graph by changing the GraphTitle 
property. Resize the form and chart if desired. 

7. To use your own data instead of the random poims. select the property 
GraphData. and type your own values. Press ENTER after each data poi m. For 
this exercise. use the following poiilts: 

10, 15. 25. 5. 35. 10 

8. To change the graph at run time. place a button on the form. Set the name to 
CmdBar. and set the Caption to "Change to Bar Chart". 

9. In cmdBar_Ciick. write the following code to altemate between a pie chart anda 
bar chart. 

Sub c~d9a:.-_C~ick (J 

· 3ar c:O.a:.-: 

-~ c~d3a:.-.Capc~on "Cha~ge to 3a:.- C~a:.-:~ :~~~ 

G:::a?r::. D:-a·Nt-!ode = 1 ' c:ea= 

Gra?~~.G:.-aphType = 4 '3a:.- C~a=: 

G:.-aphl.GraphTl.:le = ·:1y Fi::-s:. 3a= ::::.a=:· 
c~C3a:.Cap~ion = ·c~a~ge :o ?i~ c::.a=:· 

Gra;;:::. DrawMode :2 :J:.-a·~ 

G=a¡:¡::.:.DrawMode : c:ea= 
G=a;::.!.Gra~hType = 2 '?ie c::.a=: 
G:.-a;;::.:.GraptT~:l~ = "My f~=s: ?~e :::.a=:· 
c::-.c=a= .Cap¡:~o:-: = ·c::ar.ge :a 3a= -:::.a=:· 

Gra¡:¡h:. D=a•..,.Mode = 2 ' !:1:-a•..r 

O:od :: 

Exercise 2A: Testing the Solution -Simulating 50 Buttons 
In this exercise you will simulate a 50-button control using a bitmap. By using a 
user-defined coordina te system and detecting the X. Y coordinates of your mouse 
pointer. you can calculate which button is "pressed ... 

• Run the solution in C:\VBLABS\GRAPHICS\Bl:TIONS. 

Click a button. and note the message that is displayed. The 50 bunons are all in 
a single bitmap that is in a picture control. The ~louseDown event for the picture 
control converts the mouse location toa number and displays that to you by 
means of a mt!ssage box~ 

\Vhen you are comfortable you know how the program works. open the partial 
solution in C:\VBLABS\GRAPfllCS\BUTfOKS\PARTIAL. 

• 

f 

1 

f 

1 

• 
• 
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Exercise 28: Coding the Application-Simulating 50 Buttons 
Be sure you ha ve opened the partial solution in 
C:\VBLABS\GRAPHICS\BU1TONS. 

J. Create a picture box. size it. and set the picrure property to . 
\VBLABS\GRAPHICS\BUTTONS'u\1EMORY.BMP. Set the AutoSize 
property to True. 

' You'Jl wam to set up a user-defined scale on the picrure box. The idea is to 
establish a coordinate system that corresponds to the bitmap. The biunap is a 
''5x 10 .. bitmap. soto speak. so you want a 5x JO coordinate system. This way, 
any mouse event that occurs on the picture box will be reponed with X and Y 
coordinates in the range 0-5 for Y and 0-10 for X. 

You'IJ need to set ScaleLeft and ScaleTop as well. Here. you·re establishing X 
and Y values forthe origin. You may either use a 0,0 or l. J. but this will affect 
what you do later. 

a. Set ScaleMode to UserDefmed · 

b. Set ScaleWidth to 10 

c. Set ScaleHeight 10 5 

d. Set ScaleLeft 10 O 

e. Sel ScaleTop tOO 

Note lhat these properties could be set in Fonn_Load instead of at design time. 
Also. the four s1a1ements 10 set ScaleWidth. ScaleHeight. ScaleLeft. and 
ScaleTop can be reduced toa single call 10 the Scale me1hod. 

3. Code the Picture_~louseDown evenl to display a message box indicating which 
bunon was ··pressect:· 

In the :'vtouseDown evem. the incoming argumems X and Y 1ell the function 
where lne mouse poimer was. The ,·aJues of X and Y will be in the range you 
specified in the previous slep 0-5 for Y, and 0-10 for X. Note thal X and Y are 
single precision numbers. which means you'Jl get values for X Jike 5.551. 

You C:lll detennine rhe currem row by using ?.ow .. !n-;.!YI. You can determine 
the curre m column by using =o: · = :,: lXl . 

The calcula1ions to determine which "bu non .. corresponds to the mouse poimer 
are as follows if ScaleLeft and ScaleTop are both set to 0: 

Bunon selected =(Col • 5) + Row + J. 

However, you'IJ have lo determine whether the mouse bunon was pressed while 
the mouse poin1er was belween burtons. Consider the picture control as being 
comprised of a grid of size 5 by 1 O. Each bu non occupies only 84'k of the width 
of ils grid ce JI and 74% of the height. (These values were derived empirically.) 
It's easier 10 show by example than by explanation. Look at the solution if you 
need hdp . 

In most systems, a button · s code is not executed umil a MouseUp occurs and the 
mouse poimer is slill on the bunon. You could expand this application to trap the 
X. Y location in the MouseDown ~nd execute the code in the MouseUp only if 
the user was Slill in the same location. 

4. Disp!Jy the currenl X. Y mouse coordinates in the label 1hat is airead y provided. 
Add this code 10 1he Picrure_:-.Iouse:-.love event so the label is constantly gening 
updated. · 
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CHAPTER 

Welcome to the Microsoft ODBC 
Desktop Database Drivers Pack 

Welcome to the Microsoft-» Open Database Connectivity (ODBC) Desktop 
Database Drivers Pack vers1on 2.0, a set of ODBC drh·ers lhat you can use to 
access the most common database fonnats found on your desktop computer 
system. 

You can use the ODBC Desktop Database Drivers with your ODBC-enabled 
Wmdows-based applications. Through the::.e drivers, your apphcations can access 
data in seven databa~e formats: Mtcrosoft Access<il, Microsoft FoxPrOCII, dBASE. 
Paradox. Btrieve, Microsoft Excel®, and fonnaued text tiles. 

You can also use the ODBC Desktop Database Drivers to access data Wtth cu~tom 
appiLcauons wnnen ""!th the C, C++, or Visual Basic programmmg languages and 
the ODBC Software Development Kn. 

About This Manual 

/ 

Thts manual do;:scnbes ODBC and the ODBC drivers for accessing desktop data. 
lt explains how to set up ODBC dnvers on your computer sy!>tem. 11 also provides 
information about redtstnbuting the drivers for softwan: developt:rs v.ho are 
licensed to do so. 

Th1s manual as!>umes that you are farmhar with the basic tenntnology and 
procedures for usmg Microsoft Windows"' version 3 1 or later (for 16-bit driver!>) 
or Microsoft Windows NT version 3.5 or later (for 32-btt drivers). 1t also assumes 
that you ha ve set up the Windows operating environment. 



2 

How ODBC Works 
ODBC has four components an ODBC-enab!t:d application, the ODBC Driver 
Manager, ODBC database drivers. and data !.ources. 

• Applicalion A program lhat accesses data through ODBC dnvers. For 
example, a program that retrieves dBASE data wilh the OOBC dnver for 
dBASE files and Microsoft Excel data with the ODBC dnver for Microsoft 
Etcel files. 

• Driver Manager Manages drivers on lxhalf of an applicat!On. 

• Drivers Process ODBC requests and retum data to the apphcat10n. lf 
oeoessary, dnvers modify an apphcation's request mto a fonn that i~ 
understood by lhe data source. 

• Data sources The files or databases accessed by a driver. For the ODBC 
Desktop Database Dnvers, a data source is a default duectory ora single 
dalabase file. If the data source is a directory, the data source includes the files 
in lbat dLreClOI)', and the infonnation needed to access the data in those files, 
sudt as the formal of a text file. 

The following diagram shows the relationship between the four required 
compooents. 

Applicalion 

---------· . ._ OOBC lntertace 
· Dnver Manager ~ 

Driver 1 Driver. 1 Drivér 

1 . 1 . .. 1 

o ... 
Sowce 

Dota' 

Sourcé 

When you set up the ODBC Desktop Database Drivers, the Driver Manager and 
on~ or more ODBC dri\ers are instalkd on your de~ktop computer :.y:.t<!m. Your 
ODBC-enabled applicattons can then use the drivers 10 lll.:cess your ex1sring data 
sources. 
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Using Applications with ODBC Drivers 
Because many data sources differ m the SQL statements and capabthties they 
support, ODBC provides severallevels of functionality that a driver can support. 
The ODBC Desktop Database Dnvers support the funclionality requ1red by most 
ODBC-enabled applications. Furthennore, the drivers provide (with few 
exceptions) a consistent leve! of functionality for all the databases represented by 
the ODBC Desktop Database Drivers. 
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For more mfonnatJOn about the ODBC functions and SQL statements supported 
by each driver, see the driver·specific He\p files.~descnbed in "Getting Help about 
ODBC Drivers," in Chapter 2. 



CHAPTER 2 

Using the ODBC Desktop 
Database Drivers 

·, 

The ODBC Setup program decompresses and copies ODBC drivers and other 
ODBC files to your hard dbk. Befare you can start using ODBC dnvers, you 
must use ODBC Setup 

In th1s chapter, you'lllearn how lO set up ODBC on your hard d1sk, configure 
data sources, and get help about the drivers. 

Hardware and Software Requirements 
To u::.e the ODBC De::.krop Database Dnver:.. you need: 
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An IB:-.1:-compauble personal computer with an 80386 or higher processor and 
a VGA or h1gher-re~olution graphtr.:~· card 

Mu;rosoft WmdowsT'1 operating system version 3 1 or later (for 16-bit drivers) 
or Microsoft Windows NT operaung ~ystem vers10n 3.5 or later (for 3:!-bLt 
drivers). 

A hard dtsk with 6MB of free disk space for 16-btt or 32-bit drivers. 

• At least -1MB of random-acce'is memory (RAM). 

Applica!ion developers who write C language programs that cal! functions in the 
dnvers also need the Microsoft Open Database Connectivlty Software 
Development K1t. 

-Note Sorne dnvers ha ve adJ1t10nal software requtrements. See Appendi"<. Afora 
li~t of dm er-sped!i.: softv..,ue requtremenb. 
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Setting Up ODBC Desktop Database Drivers 
Tbc ODBC Setup program allows you to sct up drivers from the dismbution dtsk 
or <Wlomal!cally from a network drive (The automauc setup procedure can only 
be mc:d to set up 16-bil drivers, not32-bit drivers.) 

Setting Up ODBC Desktop Database Drivers from Disk 
TbeOOBC SeiUp program al!ows you to select the driH!ts you want and installs 
lhem on your disk. In addttton 10 the drivers. Setup tnstalls the ODBC files 
nec:ded to configure and use lhe drivers with ODBC-enabled apphcattons. 

'lbe ODBC Desktop Database Dnvers Pack includes two setup dtsks: one for 16-
bit drivers and one for 32-bit drivers. Each dt!>k contains aH the files needed to set 
llP tbeassoctated drivers. Make sure you use the 16-bit setup disk to set up 16-bit 
drivers and the 32-bit !>C:tup disk lO :.et up 32-blt drivers. The setup process you 
oecd to follow (as expla1ned below) is the same for each disk. 

11- To sd up ODBC Desktop Database Drivers 

l. lfWindows 3.1 or later. or Wmdows NT 3.5 or later, is not already runmng, do 
tbe following: 

• For Wmdows 3.1 or later, type win at the command prompt and then press 
ENTE R. 

• For Windows NT 3.5 or later. you need only boot your workstation and log 
in. lf you are runnmg a dua\.t)(JOl system, then reboot your workstatJOn and 
choo~e .. Micro!>oft Wmdows NT ·• dunng the system countdown. 

2. Aftcr your Wmdows operatmg S)''ilem begin~ running. clase any open 
applications except the Program Manager. 

3. From the Program Manager File menu. run SETUP EXE 

4. Follow the instruct¡om d1sp!ayed in the Setup program's dwlog boxes. 

Note Mtcrosofl ODBC Setup installs ODBC components and d¡i~·er!ó'rn ~our 
Wiodow!o d1rectory and the directory that contatns system dynamic·link 
hbmies (DLLs) (for Wmdow~ 3.\ or later. usua\Jy the C:\WINDOWS and 
C:\WINDOWS\SYSTEM directories: for Window~ :"'T 3 5 or later, usual! y the 
C:\WINDOWS and C:\WINDOWS\SYSTEM32 d1rectones) 

S. Sekct the dnvef!o that you want to install from the hst and then click O K. 

6. If Setup detects a copy of a dnver airead y installed and it is the same or 
a B!'wer version than the one you are installing. SeiUp displays a \l.aming. Do 
ooe of the following: 

• To overwrite the existing driver, cltd.. the Y es button. 

• To keep the existing driver. click the No button. 

• 
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7. After the msta\lation of the ODBC Desktop Datab~se Drivers is complete, you 
can add data sources for the drivers you installed. To add data sources now, 
follow the instructiDns in .. Addtng, Modifying. and Deleting Data Sources, .. 
later in th1s chapter. To ex11 the Setup program without adding data sources, 
click the Close button. 

Note You must add one or more data sources for each ODBC dnver befare 
you can access data wtth thut driver For more infurmation. :.ee .. Addmg, 
Mochrymg, and DeletiniData Source~." later in this chapter. 

8. When Setup is complete, click the OK button, or press ENTER. You are 
retumed to Wmdows. 

Setting Up 16-Bit ODBC Desktop Database Drivers Automatically 
In a muhiuser environment, a network administrator ~an configure lhe 16-bit 
OOBC Desktop Database Dnvers to be set up autom:nically from a network drive 
Amomatic !>etup provides all users with the same ODBC dnvers and data sources. 

Note The automatic se!Up procedure can be used lo set up the 16-bit ODBC 
Desktop Database Drivers, but not the 32-bit drivers. The 32-bit ODBC dnvers 
mu:.t be ~el up from disk (see "Setting Up ODBC Desktop Database Drivers from 
Disk") 

.,. To set up ODBC De!oktop Database Drh'ers automatically 

l. As k your network admintstrator for the addre~s of the network dnve 
contaimng tht! ODBC Deslo.tllp Databa~e Dnvers 

2. lf Windows 3 1 or later is not already running, ty~ "in at the command 
prompt and then press EYrER. 

3. After your W~ndow~ operatmg system begins running, c\ose any open 
applications e:-;cept the Program Manager. 

4 .. Connect to the network drive contamtng the ODBC Desktop Database Dnvers. 
lf you ha ve any questwns, ask your network admintstrator. 

5. From the F1le menu_. choose Run (ALT. F. R) 

6 Type the full path of the ODBC Setup program. fol!owed by the /auto switch. 
and then press Ei'ITER. For example, if your network drive is 0: and the ODBC 
Setup prograrn i~ m the \ODBC directory. type o:\odbc\setup /auto After the 
~ofmare !S set u p. )Ou are retumed to \\. tndows. 



8 Getting~ 
,.. To ronfigure the ODBC Desktop Oatabase Drhn:s for automatic setup 

t. Cunncct toa network d1rectory to which all users ha ve access. 

2. Create a dcrectory from which other u~rs will mstall the ODBC Dellktop 
Oa1abase Dnvers. For ellampk if the oetwork. drive is 0: and mher users will 
iastull the software from the \ODBC directory, ty~ mkdir o:~ be. 

lote The ODBC Deskwp Database Drivers Pack includes two setup d1sks: 
me for 16-bn drivers and one for 32-bit drivers. Only the 16-bit driver setup 
óst. should be u:.ed for au10malic setup of the 16-bit drivers. 

J. Copy al\ the files on the ODBC Desktop D:llabase Drivers d1sk.s (except the 
32-bit driver setup dtsk) to the newly created directory. For example. if other 
wers WJ!I install the software from the 0:\0DBC dLrectory.type copy a:•.• 
o:\odbc for each disk. 

4. On a system that does not ha ve ODBC mstalled. in~ta\1 the ODBC De~ktop 
1>3tabase Dnvers and add alllhe data sources your users ne!!d. For more 
íafonnation. see "Setung Up ODBC Desktop Datab.tse Drivers," earher m this 
dlapter 

S- Copy the ODBC.INI and ODBClNST.INI files from the system u<;ed in the 
previous step to the network directory created in step 2. For example. if the 
nct""ork dnve is 0: and other users will install the software from the \ODBC 
directory. type: 

copy c:\windows\odbc.ini o:\odbc 
c:opy c:\\o\'indo\o\'s\odbcinst.ini o:\odbc 

lfWindov.s ts m~talled m a directory other than C:\WlNDOWS. use th.tt 
directory 

6. \\"uh .t tex.t editor :.uch as Notepad. add the foilowing two lin!!s to the [F¡lesj 
sec110n of the SETUP LST file on th!! network directory: 

odbt:inst.ini = odbcinst.ini 
odbdni = odbdni 

Additional Setup lnformation 
ODBC Setup cop1es the ODBC dnver files into the directory that contains system 
DU..S (for Windows 3.1 or later, usually the C:\WINDOWS\SYSTEM directory: 
for- Windows NT 3.5 or later. usual! y the C:\WINDOWS\SYSTEM32 d1rectory). 
For Windows 3 1 or later. it abo creates two ti le~ in your Wmdov.s direcwry: 

ODBCINST.INI stores mformation about the ODBC drivers mstalled on your 
s~em. 

OOBC.INl stores information about data sources created through the ODBC 
comrol panel device or ODBC Admimstrator. 
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For Windows NT 3.5 or later, this infonnation Í\ !>lored in the regtstry. 

The ODJ3C control panel dev1ce is addcd to the [MMCPLJ seclion, or the 
CONTROL.! NI file in your Windows dircctory (for Wmdows 3.1 or later) or the 
regi!>try (for Wmdows NT 3.5 or later). Setup does not mod1fy your 
AUTOEXEC.BAT, CONFIG.SYS, or WIN.INI files. 

lfyou already ha ve ODBC dnvers on your system. installing the ODBC De~ktop 
Database Drivers: 

• Preserves your ex1stmg data sources. 

Preserves your exi~tmg ODBC driver!> and add~ the ODBC Desktop Database 
Drivers 

Automatically overv,:rites exisung ODBC components o11/y if the components 
shipped with the ODBC Desktop Database Drivers are newer. 

Adding, Modifying, and Deleting Data Sources 
A data ~ource assocwtes a particular ODBC driver with the data you want to 
access through that dnver. For examplt!, you m1ght create a data ~ource to use the 
ODBC dBASE dnver to access one or more dBASE ti les found in a spec1fic 
directory on your hard disk ora network drive. 

You can create multtple data ~ources. each one ussocta4_ng a driver with <;ome 
Jata you want to access usmg that driver. You net:d to gtve each data source a 
nam!! that uniquel) identifie~ th.u data \Ource. For exJmpk. ¡f you create a data 
~ource for a set of dBASE files th..¡t contain customer infonnation, you might 
name the dat.t source ··customers." Appilcatiom typh:ally display data sources 
names for u .. ers to ..:haos!! from. 

.,. To add a data source 

l. In the !\lain group tn the Program Manager w¡nJow. double-click the Control 
Panel icon. ln the Control Panel wmdow. double·chck thc ODBC icon. 

Note For r-.hcro~olt Windows NT 3.5 or later when u~ing l6-b1t dri\ers, stan 
th!! ODBC Adminhtr.ttor by double-clu.:long the ~llcrosoft ODBC 
Admin1~trator icon in the 1\ihcrosolt ODBC group 

2. Chck the Add bullan. 

In the Add Data Sourc!! dialog bnx, the ln,talkd ODBC Dnvers li<;t contain~ 
the nJm.:~ of currently in~t.tl!ed drivers (To m'ta!! additiona\ ODBC drhers. 
use the Dri\ers buuon m the Data Sources d1alog bo"<.) 

3. From the lnstalled ODBC Drivers list. se\ect th!! driver for the data source to 
use. 

9 
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4. Oick the OK bunon. 

A driver-specific dialog box. appears. 

5. EJarer information about the data source, ~w;h as its name and ti le vers10n {for 
ew.mple, dBASE 111 or dBASE IV). 

Ex:h dnver-specific data source dialog h:c. a Help buuon that provides 
infcnnation about adding a data source for lhe dnver you ha\e chosen. 

6. Click the OK button 

• To modiry a data source 

l. In the Main group in the Program Manager wmdow. double-dick the Conuol 
Panel icon. In the Control Panel wtndow, double-dick the ODBC icon. 

Ncb For Mtcrosoft Windows NT 3.5 or later when u~1ng 16-btt dnvers, smrt 
the ODBC Admimstrator by double-clickmg the Microsofl ODBC 
Administrator icon in the Microsoft ODBC group. 

::!. Sdc:ct a data source from the Data Sources (Driver) lisr. 

3. Clad. the St:tup button. 

A driver-specific dialog box appears. 

4. Modify lhe dala source mformation. such as 1ts name and file version (for 
example, dBASE IIl or dBASE IV). 

Each driver-specific data ~ource d~alog box has a Help buuon that provtde~ 
information about modtfying a data source for the driver you ha\e cho~en. 

5. Clid. the OK button. 

~ To ddcle a dala !>Ource 

In thc! M:un group in the Program ~1anager wmdow. doub\e-cltck the Control 
Paneltcon In the Control Panel v.indow, doub\e-cltck the ODBC icon 

Note For Mu.:rosoft Wmdow~ NT 3.5 or later when using 16-bit driver~. start 
~ ODBC Admimstrator by double-clickmg !he Microsoft ODBC 
Admimstrator icon in !he Microsoft ODBC group. 

~ Seh=cl a data .. ource from the DJ.ta Source .. lDn\er) lbt. 

3. Clid; the Delete buuon. 

4. A message box appears askmg you to verify lhat you want lo remove the data 
source you ha ve !.elected: 

Click the Y es buuon 10 delete the data source. 

Click the No button to retum to the D.1.ta Sources dwlog box wtthout 
dele~ng the data source. 

/ 
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Getting Help About ODBC Drivers 
One He\p file covers all of the ODBC Desktop Databa~e Driver.:. This file 
(ODBCJET.HLP) contains informalion about each dnver. For example, the Help 
file telb you how to set up each driver, what functionJ.Iny it support'>, and how u 
is implemented Most mfonnation in the Help file app\ies to all of the ODBC 
Iksktop Databa'>e Driver.:.. When information is apphcable lo one or more, bu! 
not all, drivers, 1he Help file identifies the dnver(s) 10 which lhe infonnation 
applies. The Help lile conta1ns three leveb of infonnalion: 

• For All Users How to sel up and u~e the dnver. 

For Advanced Users Whal SQL '>latemenls and data types lhe driver 
supports. 

For Programmers How the driver ts implemented and how to callthe driver 
progr.lmmalically. 

The driver Help file is placed in the directory thJ.t comains Windows system 
DLLs (usual! y lhe C:\WINDOWS\SYSTEM directof)l. 

Using the Driver Help File 
To u<;e the driver Help file. you can either run it from the Program Manager or 
create an icon for the Help file and double-click the icon. 

,. To run the drh"er Help file rrom the Program Manager 

1 lf Wmdow~ ts not J.lready runmng,type \-\o in althe ~!S-DOS prompt. 

2. From the File menu, choo'>e Run (ALT. F. R). 

3 Type winhelp odbcjet.hlp, ami then pres::. ENTER 

4. Al'ter you ha\ e lintsheJ reading the Hdp file. choo~e Exit from 1he File menu 
(-\LT.F.X). 

lil- To create an icon ror the driver Help file 

l. Open the group to which you want to add 1he icon. 

2. From the Ftle menu in Prograln ~lanager, choo-.e ~C:\V (.~LT. F. N). 

The New Program Object dwlog bo/1. appean.. 

3 Select the Program Item option, and then choose the OK buuon. 

The Program ltem Properties dialog box appears. 

-t In the De:-.cription bo\. type J. de\cription of the driver Hetp For example, 
OUBC Drinr Help. 

5 In the Command Lme box. type \o\oinhelp odbcjel.hlp. 

6. Choose the OK buuon. You can now double-click the icon lo vtew the driver's 
Help file. 
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Using the Driver Help File from Your Application 

If )OU are an apphcation developer, you may "'anliO access the dnver Help file 
from your applicauon or from your application's Help file. 

'To access the dnver Help file from your C language applicat10n, call the 
WinHelp function in the Windows SDK and ~pt!CIIy the full path of the Help file 
in the lps:HelpFJle argumem and HELP _CONTENTS in the JuCommaml 
.-gum..:nt. For more infonnation, see the Windows SDK Programmer's Reference 

To acce~s the driver Help file from your application's Help lile. create a jump to 
the contents • context ID of the driver Help file. For more infonnation. see the 
Windows SDK Programmer's Reference. The contextiD of the contents of lhe 

. OOBCJET HLP Help file is ODBCJetContents. 

Microsoft Product Support Services 

CompuServe 
"T'be Microsoft Connection on CompuServe provides online technical information 
for Micro!<.oft products, including the ODBC De~ltop Database Drivers With th~: 
Microsoft Conn~:~uon, you can exchange messages wuh M1crosoft professionals 
and experienced Microsoft users, and you can download free software-such as 
paKhes, tools, anJ add-ons-provided by Microsoft and CompuServe member:. 

By using the Microsoft Connectwn, you can access the Microsoft Developer 
Sctvices area You are encouraged to use this area to spea~ d~rectly to M1cro~oft 
about developer-rdated Jssues. The M1crosoft Developer Services area offers the 
fotlowing advantages: 

• Oneloper Forums The ODBC section of the Windows Extenswn 
tWinEXT) forum prm 1de~ infonnauon about the ODBC API. app!Jcation 
de\.elopmem, and driver development (GO WINEXT). The ODBC D~ltop 
Drhers sc:ction of the WinEXT forum provides infonnation about the u:.e of 
the ODBC Oesk.top Oatabase Drivers. The section leads for these sections are 
from Micro:.oft Product Suppor1 and can help answer your que!<.tions about the 
De~ktop Database Dnvers. 

• Confidenliul Technical Service Requests M1crosoft offers prívate (fee
bascd per inciden!) technical support to help sol ve your more complet 
&:vdopmem problems. For more details, see the Microsoft Oeveloper Ser.·1ces 
arl!;.~. 

• ~lit:rosoft Kno\\ ledge Base This up-to-Jate rc:ference too[, compih=ll by 
ll.li..:ro,oft Product Support, contains developer-specific technical informauon 
about ~licrosoft product:> (GO MSKB). 
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To connect to the M1cro~of1 Conneclion, type GO MICROSOFT at the 
CompuServe ··r· prompt. For informa110n about es1abhshing a CompuServe 
account. call (800) 848-8199, 8:00AM to 10.00 P M EST Ask for operator 230 
and receive a $15 connect-time usage credit. 

Support Plans 
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Microsoft also offers pay-as-you-go te\ephone !<.Upport from a Microsofl Engineer 
anda vanety of annual pa1d support plans. In the Unned States, cal! (800) 936-
3500 for further mformation on Micro!<.oft support opuon!<.. Outside of the Umted 
S tate!<., contact your local Microsoft Subs1diary for infonnation regarding the 
ava¡lability of these products and ser.·ices . 
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Additional Driver-Specific Software 

WLth the exception of the ODBC Btrieve driver. no additional database soflware 
is required for any of the ODBC Desktop Databa.se Drivers. For ex.ample, lO 
access P.imdoll data, the Paradox dnver does not require that you have a copy of 
Paradox. 
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The ODBC Btrieve dnver requires the stand-alone Btneve for Wmdows dynamLC
hnk library (DLL). WBTRCALLDLL. This file must be in the directory that 
contains Wmdows system DLLs (u:.ually the C:\WI!\"DOWS\SYSTEM directory) . 

.,. To check if you already have a copy of this file on your hard drive 

l. In the Main group. choose the Ftle Manager icon. 

2. From the File menu, choose Search. 

The Search dialog box appears. 

3. In the Search For box, type WBTRCALL.DLL. 

-t In the Start From box, t}pe C:\. 

5. Choose the OK bunon. 

lf this file exists, copy it 10 the directory that contams Wmdows system DLLs 
(usually the C:\WINDOWS\SYSTEM dtrectory). 

lmportant lf you airead y have a copy of WBTRCALL.DLL m your 
C:\WINDOWS\SYSTEM direc10ry, contact your sys~<!m admim:.tra10r befare 
copying over Lt. This file may be U!>ed by other progrJm~ on your computer. 

lf you don't ha ve a copy ofthts file, contact Novell,lnc. at (800) 453-1267 or 
your local software dea\er. Outside of the United Sta;~. contact your local Novel\ 
dtstributllL 



APPENDIX B 

Redistributing ODBC Desktop 
Database Drivers (Application 
Developers Only) 

If you are a commercial applicatlon deve\oper and you want to redbmbute the 
ODBC Desktop Database Drivers, fol\ow the mstruction~ for redistribuuon of 
drivers in your hcen:.e agreement. lf your license agreement does not cover 
redistnbution of dnvers, contact your Microsoft sales representative for more 
infonnatton. 

Setting Up ODBC Components for Your Application 
The ea:.•est way to set up the ODBC Desktop DatabaS!! Drivers for your 
commercial application is to redistribute copies of the disk on whtch they were 
shippt:d and ¡nstru..:t u~ers 10 follow the ~etup procedure:. lhtt:d m Chapter 2, 
.. Sening Up the ODBC De:.ktop Datab.u.e Drivers." 
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You ':m abo integr:J.Ee the :.ctup of ODBC componen!' tnto your application':. 
:.etup program by c.tlhng functions in .the ODBC lnst.11lcr DLL (ODBCINST.DLL 
for 16-btt :~pplication~ orODBCCPJ::!.DLL for 32·btt appltcation~l The ODBC 
In~t.1lkr DLL m~talls ODBC componen!:. and ts shipp~d "llh the ODBC De:.~top 
D.ttabase Dmers 1t includes both htgh-\evel and !0"-·11!\'d function:. for 
ln\t.tlhog ODBC component:.. For more mformauon Jbuut thl! ODBC ln:.t.tller 
DLL. <;.;:e the A/!crosoji ODBC SDK Programma's Rt'j(reiiCf!. 

Note The ODBC lnstaller shipped wnh the ODBC De~~top Database Drivers 
~uppotts the functiom. de~cribed in Chapter 2.¡. "lnstalkr DLL Functwn 
Reference," ofthe ;\llloowjf ODBC SDK Prograuima's Rejerenet.', renir•n 2 O. 
1t aho ~upports se~l!ral new functlOO'i that pfO\ide a _:;raphk.tl u~..:r mterfa~·e t'rom 
"hi.:h u-.crs can in,tall ODBC componem-; anJ .:onli:;ur..: JJ.t.l :.llUrt:e,, 



18 Gel1lng S1alted 

ODBC Component Files 
If you intend lo redistnbute all of the ODBC De~ktop Databa~e Dnvers Wlth your 
commercial application and you intend to use the ODBC Setup program, you 
must sh1p al! the files on the ODBC Desktop Databa!>e Dnvers disks. Otherwise, 
you need to :.hip only the files for the ODBC components your apphcation 
requires; the ODBC.INF file you ship must reflect these components. For more 
information about the ODBC.INF file, see the Microsoft ODBC SDK 
Programmer's Reference. 

Note You must ship the Driver Manager and the lnstaller DLL Wtth any ODBC
enabled applicauon. Ifyou wish to configure 16-bit drivers in Wmdows NT, you 
must abo sh1p the ODBC Administrator (00BCADM.EXE). 

The following table lists the files required by each component of the ODBC 
Deshop Database Dnvers. Sorne files are requtred by more than one component. 
Although you need to ship only a smgle copy of a common file, you must list 1t in 
the section of the ODBC.INF file of every component that requues il. 

ODBC eomponrnt 

Buirve Dnver 

Rrquircd files 

BTRV200.DLL 
CTL3DV20LL 
ODBCJET.HLP 
MSAJTIOO.OLL 
ODBCITI6 DLL 
COMPOBJ.DLL, 
OLE:!.DLL 
OLE:! Rf:G 
OLE~Sl.S DLL 
OLE~UISP OLL 
SCP Dl.l. 
STDOLE TI.B 
STORAGE DLL 
TYPELIB OLL 
VBAR:!.DLL 
VAEN2 DLL 
VAEN2.0LB 
VBAJET.DLL 

Appendix' B Redislributing ODBC Desklop Databa se Drivers (Apphcation Developers Only) 

ODBC component 

dBASE Dnver 

Dnver Manager 

rvhcro~oft Access Dnver 

Required files 

XBSZOO DLL( 16-bit)r.-.ISXB203Z.DLU32-bit) 
CfL3DYZ.DLL( 16-bnliCfL3032.DLL(32-bltl 
ODBCJET.HLP 
MSAJT200 DLU 16-btt)f.\.1SJT2032. DLL(32-btt) 
ODBCJT\6 DLL( 16-bn)/0DBCJT32.DLL(32-bn) 
COMPOBJ.DLL 
0LE2.DLL 
OLE2.REG 
OLE2NLS.DLL 
OLE2DISP DLL 
SCP DLU 16·bit)/SCP32 DLL(32-btt) 
STDOLETI.B 
STORAGE DLL 
TYPELIB DLL 
VBAR2 DLL( 16-bn)!Y8AR232 DLU32-bit) 
V AEN2.DLL( 16-b•t)/V AEN232.DLL02-bit) 
VAEN2 OLB(I6-bit)l VAEN232.0LB(32-btt) 
VBAJET.DLL( 16-bu)/ VBAJET32. DLL(32-btt) 

CTL3DV2.DLU 16-bitliCTL3032.DLL(32-bhJ 
ODBC.DLU 16-bu)ÍODBC32.DLL(32-btt) . 
OpBCCURS.DLL(I6-b.t)IODBCCR32 DLL(32-bil) 

CTL3DV2.DLL(I6-bai/CTL3D32 DLL(32-b•t) 
ODBCJET.HLP 
MSAJTIOO.DLL( i6-bii)I~IS1T2032.DLU32-bitl 
ODBCJT 16. DLL( 16·bu1JUDBCJT32.DLL(32-bit) 
COMPOBJ .DLL 
OLE2.DLL 
OLE:! REO 
OLE}SLS.DLL 
OLE2DISP DLL ... 
SCP.DLU 16·b•tlfSCP32.DLL(32-bit) 
STDOLE Tl:.B . 
STORAGE.DLL 
TYPELIB DLL 
VBAR2 DLL( 16-blti1YBAR2J:!.DLL(32-bit) 
Vo\EN::! DLU 16-biiJ/\'AEN232.DLU32-btt) 
VAE:'\~.OLBtl6-biiJ/ \' AE:--1232.0LB(3]-btl) 
VBAJET.OLL( l6-bit1i VBAJET32 DLU32-bit) 
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20 .:iDg Started 

ODBC componen! 

Micro,ofl Excel Dnver 

Microsoft FoxPro Dnver 

ODBC Admim~tr:uor 

ODBC ln~taller/ 
Comrol P.md D<vke · 

·-· 

Required file. 

CTLJDV:?:.DLL( l6-bnJ/CTL3D32 DLL/32-btt) 
ODBCJETHLP 
ODBCJT16 DLL\16-btt)IODBCJTJ:?. DLL(32-bttl 
MSXL20\6 DLU l6-bli)/MSXL2032.DLU32-bttl 
MSAJT200_DLL ( 16-b•t)IMSJT2032 DLL (32-bttl 
COMPOBJ DLL 
OLE2 DLL 
OLE2.REG 
OLE2NLS.DLL 
OLE2DISP.DLL 
SCP.DLL( 16-btt)/SCP32.DLL(32-bu) 
STDOLETLB 
STORAGEDLL 
TYPELIB.DLL 
V BAR2.DLL( 16-bit)/VBAR232.DLL( 32 -bit) 
V AEN2.DLL( 16-btt)/V AEN232.DLL{32-bil) 
VAEN2.0l8( 16-bit)/ VAEN232 OLB(32-bit) 
VBAJET.DLL( 16-bu)/ VBAJET32.DLL(32-btt) 

CTLJDV2.DLL( 16·btt)ICTL3032 DLL(J2-bil) 
ODBCJET.HLP 
MSAJT200.DLLt 16·bli)IMSJT2032.DLU 32-bn) 
ODBCJTI6 DLL( 16-bn)/0DBCJT32 DLU32-blt) 
XBS200.DLL( 16·btt)/\-ISXB2032.0LL(32-btt) 
COMPOBJ.DLL 
0LE2.DLL 
OLE2.REG' 
OLE2NLS DLL 
0LE2015P DLL 
SCP DLU 16-bin/SCP3~ DLLtJ2-bn) 
STDOLE TLB 
STÜRAGE.DLL 
TYPELIB DLL 
VBAR2 DLU 16-bu\JVBAR~32 DLL(32·biO 
VAEN2.DLU 16-btt)N AEN232 DLL(32·btt) 
VAEN2 OLBt 16-btt)/ VAEN232 OL8(31-bu) 
VBAJET .Dll( 16-btt)/ VBAJET32.DLL(32-btt) 

ODBCADM.EXE( 16-bi0/008CAD32.EXE(32-btt) 
(ODBCADM EXE must be shtpped for 16-btt 
applicauons that run on Wmdows NT) 

CTLJDV2.DLU 16-btti/CTUD32.DLL(32-bit) 
ODBC.I~F 

ODBCI~ST DLU ló-bto/ODBCCP.l2 DLU31-bttJ 
ODBCI~ST.HLP 

WI;-..;HELP.EXE · 
WI;-..;HELP.HLP 

·-· 
Appendix B Redistnbuting OOBC Desktop Database Driver~ ,tion Devetopers Only) 

ODBC component 

_ ODBC Setup Progmm 
( 16-bit or 32-bll) 

Par.tdox Driver 

Required files 

ODBCSTP EXE 
SETUP.EXE 
SETUP.LST 
BOOTSTP EXE 
DRVSETUP DLL 

CfUDV2 DLU 16-bitJ/CTLJD32.DLLC32-btt) 
ODBCJET.HLP 
MSAJTIOO OLL ( 16-btt)/MSJT2032.DLL(32-bttJ 
PO X200 .DLL( 16-bitJ/MSPX203 2. DL L( 3 2 -btt) 
ODBCJT 16 DLLC 16-btt)/ODBCJT32.DLU32-btt) 
COMPOBJ.DLL · 
OLE2.0LL 
OLE2 REG 
OLE2NLS DLL 
OLE2DISP.OLL 
SCP.DLL( !6-btt)ISCP32 DLL(32-btt) 
STDOLE TLB 
STORAGE DLL 
TYPELIB.DLL 
VBAR2 DLLtl6·btt)NBAR232.DLLt32-bir) 
VAEN2.DLU16-bi1JfV AEN232.DLL(32-btt) 
VAEN2.0LBt 16-bn)/ VAEN2J2.0L8(32-btt) 
VBAJET.DLL( 16-bit)/ VBAJET32.DLL(32-bit) 

CTLJDY2 DLU16·btt}ICTL3032 DLL(32-bit) 
ODBCJET.HLP 
ODBCJTJ6 DLU 16-bitl/ODBCJT32.DLL(32-bttl 
MSTX.:!016 DLU 16-bitJ~ISTX::!OJ2 DLLIJ:!-bill 
MSAJT::!Oil DLL l 16-bitii'MSJT!OJ.!.DLL (32-bil) 
CO\II>OBJ DLL 
OLE! DLL 
OLE::!.REG 
OLE!~LS.DLL 

OLE!DISP.DLL 
SCP.DLL( 16·bLI)ISCP32 DLL(32·bttl 
STDOLE.TLB 
STORAGE.DLL 
TYPELIB.OLL 

~:.r VBAR2 DLU 16-bll)NBAR::!):?..DLUJ::!-t>Lt) 
VAEN:!.DL~( 16-bLt)/V AEN232 DLL(32-biiJ 
VAEN2.0L8( 16-bLt)/ VAEN:!32.0LB02-bil) 
VBAJET.DLL( 16-bit)/ VB.-\JETJ::!.Illl.l.~:!-bu) 


